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About This Guide

This guide describes the procedures necessary to operate and maintain your 
BD™ LSR II flow cytometer. Because many cytometer functions are controlled by 
BD FACSDiva™ software, this guide also contains information about software 
features required for basic cytometer setup and operation. 

For an annotated list of additional documentation for your BD LSR II flow 
cytometer, see BD LSR II Documentation on page xii.

Conventions

The following tables list conventions used throughout this guide. Table 1 lists the 
symbols that are used to alert you to a potential hazard. Text and keyboard 
conventions are shown in Table 2. 

Table 1  Hazard symbolsa

a. Although these symbols appear in color on the cytometer, they are in black and white throughout this user’s 
guide; their meaning remains unchanged.

Symbol Meaning

Caution: hazard or unsafe practice that could result in material damage, data 
loss, minor or severe injury, or death

Electrical danger

Laser radiation

Biological risk
xi



BD LSR II Documentation

BD LSR II Online Help

The online help installed with your BD FACSDiva software contains the same 
text as that in the documents listed below, enhanced with features like full text 
search and related topic links. Access BD LSR II online help from the Help menu 
of BD FACSDiva software. 

BD LSR II online help topics are compiled from the following sources:

• BD FACSDiva Software Reference Manual

• BD LSR II User’s Guide

• BD High Throughput Sampler User’s Guide

Table 2  Text and keyboard conventions

Convention Use

Tip     Highlights features or hints that can save time and prevent 
difficulties

NOTICE     Describes important features or instructions 

Italics Italics are used to highlight book titles and new or unfamiliar 
terms on their first appearance in the text. 

> The arrow indicates a menu choice. For example, “choose 
File > Print” means to choose Print from the File menu.

Ctrl-X When used with key names, a dash means to press two keys 
simultaneously. For example, Ctrl-P means to hold down the 
Control key while pressing the letter p. 
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Printed Documentation

A printed copy of the following documents is distributed with the BD LSR II flow 
cytometer:

• BD LSR II User’s Guide describes procedures necessary to operate and 
maintain your BD LSR II flow cytometer. Because many cytometer 
functions are controlled by BD FACSDiva software, this guide also 
contains information about software features required for basic cytometer 
setup and operation. 

• BD LSR II Safety and Limitations booklet discusses the safety features of 
the BD LSR II flow cytometer. It lists precautions for the cytometer’s laser, 
electrical, and biological hazards, and states limitations of use.

• BD LSR II Facility Requirement Guide contains specifications for:

- cytometer weight and size

- temperature and other environmental requirements

- electrical requirements

• Getting Started with BD FACSDiva Software contains tutorial exercises 
that familiarize you with key software procedures and concepts.

• A printed copy of the BD High Throughput Sampler User’s Guide is 
distributed with the BD™ High Throughput Sampler (HTS) option. This 
document describes how to set up and operate the HTS. It also contains a 
description of BD FACSDiva software features specific to the HTS.
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Electronic Documentation

PDF versions of the following documents can be found on the BD FACSDiva 
software installation disk or on your computer hard drive:

• The BD FACSDiva Software Reference Manual includes instructions or 
descriptions for installation and setup, workspace components, acquisition 
controls, analysis tools, and data management. It can be accessed from the 
BD FACSDiva Software Help menu (Help > Literature > Reference 
Manual), or by double-clicking the shortcut on the desktop. In addition, a 
printed copy can be requested from BD Biosciences.

• Getting Started with BD FACSDiva Software can be accessed from the 
Help menu (Help > Literature > Getting Started Guide), or by double-
clicking the shortcut on the desktop.

• The BD LSR II User’s Guide and BD High Throughput Sampler User’s 
Guide PDFs can be found on the BD FACSDiva software installation disk 
in the Cytometer User Guides folder.

• The BD FACSDiva Option White Paper can be downloaded from the 
BD Biosciences website. This white paper contains an in-depth discussion 
of the digital electronics used in the BD LSR II cytometer. 
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Technical Assistance

For technical questions or assistance in solving a problem:

• Read sections of the documentation specific to the operation you are 
performing (see BD LSR II Documentation on page xii). 

• See Troubleshooting on page 107.

If additional assistance is required, contact your local BD Biosciences customer 
support representative or supplier. 

When contacting BD Biosciences, have the following information available:

• product name, part number, and serial number

• version of BD FACSDiva software you are using

• any error messages

• details of recent system performance

For cytometer support from within the US, call (877) 232-8995.

For support from within Canada, call (888) 259-0187.

Customers outside the US and Canada, contact your local BD representative or 
distributor.
About This Guide xv
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Safety and Limitations

The BD LSR II flow cytometer and its accessories are equipped with safety 
features for your protection. Operate only as directed in the BD LSR II User’s 
Guide and the BD LSR II Safety and Limitations booklet. Do not perform 
cytometer maintenance or service except as specifically stated. Keep this safety 
information available for reference.

Laser Safety

Lasers or laser systems emit intense, coherent electromagnetic radiation that has 
the potential of causing irreparable damage to human skin and eyes. The main 
hazard of laser radiation is direct or indirect exposure of the eye to thermal 
radiation from the visible and near-infrared spectral regions (325–1400 nm). 
Direct eye contact can cause corneal burns, retinal burns, or both, and possible 
blindness.

There are other potentially serious hazards in other spectral regions. Excessive 
ultraviolet exposure produces an intolerance to light (photophobia) accompanied 
by redness, a tearing discharge from the mucous membrane lining the inner 
surface of the eyelid (conjunctiva), shedding of the corneal cell layer surface 
(exfoliation), and stromal haze. These symptoms are associated with 
photokeratitis, otherwise known as snow blindness or welder’s flash, which 
results from radiant energy–induced damage to the outer epidermal cell layer of 
the cornea. These effects can be the result of laser exposure lasting only a fraction 
of a second.
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Laser Product Classification

Laser hazard levels depend on laser energy content and the wavelengths used. 
Therefore, it is impossible to apply common safety measures to all lasers. A 
numbered system is used to categorize lasers according to different hazard levels. 
The higher the classification number, the greater the potential hazard. The 
BD LSR II flow cytometer is a Class I (1) laser product per 21 CFR Subchapter J 
and IEC/EN 60825-1:1994 + A1:2003 + A2:2001. The lasers and the laser 
energy are fully contained within the cytometer structure and call for no special 
work area safety requirements except during service procedures. These 
procedures are to be carried out only by BD Biosciences service personnel.

Precautions for Safe Operation   

Modification or removal of the optics covers or laser shielding could result 
in exposure to hazardous laser radiation. To prevent irreparable damage to 
human skin and eyes, do not remove the optics covers or laser shielding, 
adjust controls, or attempt to service the cytometer any place where laser 
warning labels are attached (see Symbols and Labels on page xxi). 

Use of controls or adjustments or performance of procedures other than 
those specified in the user’s guide may result in hazardous radiation 
exposure.

Keep all cytometer doors closed during cytometer operation. When 
operated under these conditions, the cytometer poses no danger of 
exposure to hazardous laser radiation.
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Electrical Safety

• Turn off the power switch and unplug the power cord before servicing the 
cytometer, unless otherwise noted.

• Connect the equipment only to an approved power source. Do not use 
extension cords. Have an electrician immediately replace any damaged 
cords, plugs, or cables. Refer to the BD LSR II Facilities Requirement 
Guide for specific information.

• Do not remove the grounding prong from the power plug. Have a qualified 
electrician replace any ungrounded receptacles with properly grounded 
receptacles in accordance with the local electrical code.

• For installation outside the US, use a power transformer or conditioner to 
convert the local power source to meet the BD LSR II power requirements 
(120 V ±10%, 50/60 Hz). Contact your local BD office for further 
information.

Lethal electrical hazards can be present in all lasers, particularly in laser 
power supplies. Every portion of the electrical system, including the printed 
circuit boards, should be considered to be at a dangerous voltage level. 
Avoid potential shock by following these guidelines.
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Biological Safety

• Handle all biological specimens and materials as if capable of transmitting 
infection. Dispose of waste using proper precautions and in accordance 
with local regulations. Never pipette by mouth. Wear suitable protective 
clothing, eyewear, and gloves.

• Expose waste container contents to bleach (10% of total volume) for 30 
minutes before disposal. Dispose of waste in accordance with local 
regulations. Use proper precaution and wear suitable protective clothing, 
eyewear, and gloves.

• Prevent waste overflow by emptying the waste container frequently or 
whenever the waste management system alarms.

For information on laboratory safety, refer to the following guidelines. NCCLS 
documents can be ordered online at www.nccls.org.

• Schmid I, Nicholson JKA, Giorgi JV, et al. Biosafety guidelines for sorting 
of unfixed cells. Cytometry. 1997;28:99-117.

• Protection of Laboratory Workers from Instrument Biohazards and 
Infectious Disease Transmitted by Blood, Body Fluids, and Tissue; 
Approved Guideline. Wayne, PA: National Committee for Clinical 
Laboratory Standards, 1997. NCCLS document M29-A. 

• Procedures for the Handling and Processing of Blood Specimens; Approved 
Guideline. Wayne, PA: National Committee for Clinical Laboratory 
Standards; 1990. NCCLS document H18-A.

All biological specimens and materials coming into contact with them are 
considered biohazardous. Avoid exposure to biohazardous material by 
following these guidelines.
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General Safety

Symbols and Labels

The following symbols, warnings, or precaution labels appear on the BD LSR II 
flow cytometer or the waste and fluid tanks.

The cytometer handles are for BD Biosciences authorized personnel only. 
Do not access them or attempt to lift the cytometer with them, or you could 
injure yourself.

To avoid burns, do not touch the fan guards on the back of the cytometer. 
The fan guards could be hot during and after cytometer operation.

Movement of mechanical parts within the cytometer can pinch or injure 
your hands or fingers. To prevent injury by moving parts, keep your hands 
and clothing away from the cytometer during operation.

Symbol Meaning Location(s)

� Dangerous voltage Rear cytometer panel near power 
receptacle

� Laser radiation hazard Near all removable covers and any 
place where the laser beam can 
emerge from the cytometer

� Caution! Consult accompanying 
documents.

Near the cytometer handles
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Label Meaning Location(s)

Caution

Hot surface

Rear cytometer panel 
adjacent to exhaust fans

Caution

Turn power off before 
service.

• Rear cytometer panel 
adjacent to power 
receptacle

• Near internal power 
shield

Caution

High voltage

Rear cytometer panel 
adjacent to power 
receptacle

Biological risk: Waste

Risk of exposure to 
biologically 
transmittable disease

System waste tank

Danger

Visible and/or 
invisible laser 
radiation when 
removed. Avoid eye 
or skin exposure to 
direct or scattered 
radiation.

Near all removable 
covers and any place 
where the laser beam can 
emerge from the 
cytometer

(B) Sheath Near BD FACSFlow™ 
solution (sheath) port

334972

CAUTION: 
Hot Surface

ATTENTION:
Surface Chaude

334974

!
CAUTION: 
Turn power off
before service.

ATTENTION:
Mettre hors tension
avant toute 
intervention.

334973

CAUTION: 
High Voltage

ATTENTION:
Haute tension

Waste (A)
336325 Rev. A
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Limitations

For Research Use Only. Not for use in diagnostic or therapeutic procedures.

BD Biosciences delivers software and workstations that are intended for running 
the cytometers supplied by BD Biosciences. It is the responsibility of the buyer/
user to ensure that all added electronic files including software and transport 
media are virus free. If the workstation is used for Internet access or purposes 
other than those specified by BD Biosciences, it is the buyer/user’s responsibility 
to install and maintain up-to-date virus protection software. BD Biosciences does 
not make any warranty with respect to the workstation remaining virus free after 
installation. BD Biosciences is not liable for any claims related to or resulting 
from buyer/user's failure to install and maintain virus protection.
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Introduction

The following topics are covered in this chapter:

• Overview on page 26

• Components on page 26

• Fluidics on page 28

• Optics on page 32

• BD LSR II Workstation on page 37
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ts
Overview

The BD LSR II is an air-cooled multi-laser benchtop flow cytometer with the 
ability to acquire parameters for a large number of colors. It uses fixed-alignment 
lasers that transmit light reflected by mirrors through a flow cell to user-
configurable octagon and trigon detector arrays. These detectors collect and 
translate fluorescence signals into electronic signals. Cytometer electronics 
convert these signals into digital data.

Components

Figure 1-1  BD LSR II flow cytometer

Power Switch

The power switch is located on the lower-right side of the BD LSR II cytometer.

control panel
SIP

left cover

power switch

fluidics
interconnec

right coverside door 

cytometer handle
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Handles

Control Panel

The control panel contains the following fluidics controls:

• Sample Flow Rate Control buttons

• Fluid Control buttons

• Sample fine adjust knob

Figure 1-2  Control panel

The cytometer handles are for BD Biosciences authorized personnel only. 
Do not access them or attempt to lift the cytometer with them, or you could 
injure yourself.

LO MED HI

RUN STNDBY PRIME

sample flow rate 
fluid control buttons

SAMPLE
FINE ADJ

control buttons
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Fluidics

The purpose of the fluidics system is to carry the sample out of the sample tube 
and into the sensing region of the flow cell. Cells are carried in the sample core 
stream in single file and measured individually.

Sample Flow Rate Control

Three flow rate control buttons—LO, MED, and HI—set the sample flow rate 
through the flow cell. The SAMPLE FINE ADJ knob allows you to adjust the 
rate to intermediate levels (Figure 1-2 on page 27).

When the SAMPLE FINE ADJ knob is at its midpoint, the sample flow rates at 
the LO, MED, and HI settings are approximately 12, 35, and 60 µL/min of 
sample, respectively. The knob turns five full revolutions in either direction from 
its midpoint, providing sample flow rates from 0.5–2X the midpoint value. For 
example, if the LO button is pressed, the knob will give flow rates from 
approximately 6–24 µL/min.

Fluid Control

Three fluid control buttons—RUN, STNDBY, and PRIME—set the cytometer 
mode (Figure 1-2 on page 27).

• RUN pressurizes the sample tube to transport the sample through the 
sample injection tube and into the flow cell.

The RUN button is green when the sample tube is on and the support arm 
is centered. When the tube support arm is moved left or right to remove a 
sample tube, the cytometer switches to an automatic standby status to 
conserve sheath fluid, and the RUN button changes to orange.

• STNDBY (standby) stops fluid flow to conserve sheath fluid.

When you leave the cytometer for more than a few minutes, place a tube 
containing 1 mL of deionized (DI) water on the sample injection port (SIP) 
and press STNDBY.
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• PRIME prepares the fluidics system by draining and filling the flow cell 
with sheath fluid.

The fluid flow initially stops and pressure is reversed to force fluid out of 
the flow cell and into the waste container. After a preset time, the flow cell 
fills with sheath fluid at a controlled rate to prevent bubble formation or 
entrapment. At completion, the cytometer switches to STNDBY mode.

Sample Injection Port

The sample injection port (SIP) is where the sample tube is installed. The SIP 
includes the sample injection tube and the tube support arm. Samples are 
introduced through a stainless steel injection tube equipped with an outer droplet 
containment sleeve. The sleeve works in conjunction with a vacuum pump to 
eliminate droplet formation of sheath fluid as it backflushes from the sample 
injection tube.

Figure 1-3  Sample injection port (SIP)

outer sleeve

sample injection tube

Tube support arm
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• Sample injection tube—Stainless steel tube that carries sample from the 
sample tube to the flow cell. This tube is covered with an outer sleeve that 
serves as part of the droplet containment system.

• Tube support arm—Arm that supports the sample tube and activates the 
droplet containment system vacuum. The vacuum is on when the arm is 
positioned to the side and off when the arm is centered.

Droplet Containment System

The droplet containment system prevents sheath fluid from dripping from the SIP 
and provides biohazard protection.

When no sample tube is installed on the SIP, sheath fluid backflushes through the 
sample injection tube. This backflush helps prevent carryover of cells between 
samples. The droplet containment system vacuum is activated when the sample 
tube is removed and the tube support arm is moved to the side. Sheath fluid is 
aspirated as it backflushes the sample injection tube.

NOTICE     If a sample tube is left on the SIP with the tube support arm to the side 
(vacuum on), sample will be aspirated into the waste container.
30 BD LSR II User’s Guide  



Sheath and Waste Containers

The sheath and waste containers are outside the cytometer and are positioned on 
the floor.

Sheath Container

The sheath container has a capacity of 8 L. Sheath fluid is filtered through an 
in-line, interchangeable filter that prevents small particles from entering the 
sheath fluid lines.

Before opening the sheath container:

1 Press the STNDBY button.

2 Disconnect the air line (green).

3 Depressurize the sheath container by lifting its vent cap.

Waste Container

The waste container has a capacity of 10 L. An alarm sounds when the container 
becomes full.

To avoid leakage of biohazardous waste, put the cytometer in standby 
mode before disconnecting the waste container.

The waste container contents might be biohazardous. Treat contents with 
bleach (10% of total volume). Dispose of waste with proper precautions in 
accordance with local regulations. Wear suitable protective clothing, 
eyewear, and gloves.

The waste container is heavy when full. When emptying it, use good body 
mechanics to prevent injury.
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Optics

The following figure shows the optical bench components of the BD LSR II 
cytometer. 

Figure 1-4  Optical bench components (engineering model)

Photomultiplier tubes (PMTs) Devices that convert optical signals into 
electrical signals (see Detectors on page 35)

Octagon Array of PMTs and filters that can detect up 
to eight signals (Figure 1-5 on page 35)

Trigon Array of PMTs and filters that can detect up 
to three signals (Figure 1-6 on page 36)

photomultiplier tube (PMT)

trigon

octagon

blue 488-nm laser (standard)

red 633-nm laser 

UV 355-nm laser

violet 405-nm laser

steering optics

(optional)

(optional)

(optional)

photomultiplier tube (PMT)
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Lasers

The BD LSR II flow cytometer has a fixed-alignment 488-nm laser with the 
option of additional fixed-alignment lasers.

The primary blue 488-nm laser (Coherent Sapphire) generates forward scatter 
(FSC) and side scatter (SSC) signals and four fluorescence signals.

• The optional red 633-nm laser (JDS Uniphase 1344P) generates two 
fluorescence signals.

• The optional violet 405-nm laser (Coherent Radius 405) generates two 
fluorescence signals.

• The optional UV 355-nm laser (Lightwave Xcyte) generates two 
fluorescence signals.

Lasers: blue 488 nm, red 633 nm, UV 
355 nm, and violet 405 nm

See Lasers on page 33.

Optics cover Shielding that houses the flow cell, forward 
scatter (FSC) assembly (see Detectors on 
page 35), and the excitation optics

Table 1-1  BD LSR II flow cytometer laser options

Laser Type
Wavelength 

(Color)
Power 
(mW)

Warm-Up 
Time 
(min)

Standard Coherent® Sapphire™ solid state 488 nm (blue) 20 30

Optional JDS Uniphase™ 1344P helium-
neon 
(HeNe) gas

633 nm (red) 17 20

Coherent Radius™ 405 solid state 405 nm (violet) 25 15

Lightwave Xcyte™ solid state 355 nm (UV) 20 30
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Filters

Optical filters attenuate light or help direct it to the appropriate detectors. The 
BD LSR II cytometer uses dichroic filters. Dichroic filters transmit light of a 
specific wavelength, while reflecting other wavelengths. The name and spectral 
characteristics of each filter appear on its holder.

There are three types of dichroic filters:

• Shortpass (SP) filters transmit wavelengths that are shorter than the 
specified value.

• Longpass (LP) filters transmit wavelengths that are longer than the 
specified value.

• Bandpass (BP) filters pass a narrow spectral band of light by combining the 
characteristics of shortpass filters, longpass filters, and absorbing layers. 
Discriminating filters (DF) and ALPHA™ filters (AF) are types of bandpass 
filters.

When dichroic filters are used as steering optics to direct different color light 
signals to different detectors, they are called dichroic mirrors or beam splitters.

• Shortpass dichroic mirrors transmit shorter wavelengths of light to one 
detector while reflecting longer wavelengths to a different detector.

• Longpass dichroic mirrors transmit longer wavelengths to one detector 
while reflecting shorter wavelengths to a different detector.

The BD LSR II cytometer octagon and trigon detector arrays use dichroic 
longpass mirrors on their inner rings, and bandpass filters on their outer rings. 
However, you can customize the arrays with other types of filters and mirrors. 

In the following figure, the inner ring is colored gray, and the outer is blue. 
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Figure 1-5  Dichroic filter types in octagon array

The steering optics and filters mounted on the BD LSR II cytometer are listed in 
Table D-1 on page 122.

See Optical Filters on page 95 for a more detailed explanation of how filters 
work in the BD LSR II flow cytometer.

Detectors

Light signals are generated as particles pass through the laser beam in a fluid 
stream. When these optical signals reach a detector, electrical pulses are created 
that are then processed by the electronics system.

longpass dichroic mirrors

bandpass filters
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There are two types of signal detectors in the BD LSR II flow cytometer: 

• Photodiode tubes—Less sensitive to light signals than the PMTs. A 
photodiode is used to detect the stronger forward scatter signal.

• Photomultiplier tubes (PMTs)—Used to detect the weaker signals generated 
by side scatter and all fluorescence channels. These signals are amplified by 
applying a voltage to the PMTs. 

As the voltage is increased, the detector sensitivity increases, resulting in 
increased signal. As the voltage is decreased, the detector sensitivity decreases, 
resulting in decreased signal. Detector voltages are adjusted in BD FACSDiva 
software.

Figure 1-6  PMT-type detectors in trigon array

The default locations of specific detectors and filters within BD LSR II cytometer 
octagon and trigon arrays are shown in Table D-1 on page 122.

PMT

PMT
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BD LSR II Workstation

Acquisition, analysis, and most BD LSR II cytometer functions are controlled by 
the BD LSR II workstation. It includes a PC, one or two monitors, and a printer. 

Your workstation is equipped with the following:

• a BD Biosciences–validated Microsoft® Windows® operating system

• BD FACSDiva software for data acquisition and analysis 

• software documentation including an online help system

See BD LSR II Documentation on page xii for more information.
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2

Cytometer Setup

• Starting the Cytometer and Computer on page 40

• Setting Up the Optical Filters and Mirrors on page 41

• Preparing Sheath and Waste Containers on page 45

• Preparing the Fluidics on page 48

• Quality Control on page 51
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Starting the Cytometer and Computer

1 Turn on the power to the flow cytometer. Allow 30 minutes for lasers to 
warm up and stabilize.

2 Start up the BD LSR II workstation and log in to Windows.

Tip     You can turn on the power to the flow cytometer and the workstation 
in any order.

3 Start BD FACSDiva software by double-clicking the shortcut on the 
desktop, and log in to the software.

4 Check the Cytometer window in BD FACSDiva software to ensure the 
cytometer is connected to the workstation.

The cytometer connects automatically. While connecting, the message 
Cytometer Connecting is displayed in the window footer. When connection 
completes, the message changes to Cytometer Connected.

If the message Cytometer Disconnected appears, refer to Electronics 
Troubleshooting in Troubleshooting on page 107

Failure to warm up and stabilize the lasers could affect sample data.
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Setting Up the Optical Filters and Mirrors

Before you run samples, set up the optical filters. The following figure shows the 
location of the detector arrays (beneath the cytometer covers of the BD LSR II 
flow cytometer). Each detector array is labeled with its laser source.

blue octagon

violet trigon UV trigon

red trigon 
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Filter and Mirror Configurations

Each PMT (except the last PMT in every 
detector array) has two slots in front of it. 

• The slot closer to the PMT holds a 
bandpass filter holder.

• The slot farther from the PMT 
holds a longpass dichroic mirror 
holder.

The last PMT in every detector array (PMT H in the octagon, and PMT C in all 
trigons) does not have a mirror slot.

Optical Holders, Filters, and Mirrors

Optical holders house filters and mirrors. Your cytometer includes several blank 
(empty) optical holders.

Figure 2-1  Blank optical holders, filters, and mirrors

filter slot

mirror slot

PMT A

bandpass filter

(filter slot)
blank optical holder

empty

longpass dichroic mirror

blank optical holder
(mirror slot)

empty
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NOTICE     To ensure data integrity, do not leave any slots unfilled in a detector 
array when you are using the associated laser. Always use a blank optical holder.

Base Configurations

Each BD LSR II cytometer has a base cytometer configuration that corresponds 
to the layout of the installed lasers and optics in your cytometer. 

BD FACSDiva Cytometer Configuration

Before you acquire data using BD FACSDiva software, you specify a cytometer 
configuration. The cytometer configuration defines which filter and mirror are 
installed at each detector.

BD FACSDiva software provides a BD base configuration for your BD LSR II 
cytometer. Use the Cytometer Configuration dialog to create, modify, or delete 
custom cytometer configurations. (Refer to the Cytometer and Acquisition 
Controls chapter of the BD FACSDiva Software Reference Manual for details.) 

Changing Optical Filters or Mirrors

1 Lift the appropriate cytometer cover.

• The octagon array is located under the right cytometer cover.

• The three trigon arrays are located under the left cytometer cover.

NOTICE     To open the left cytometer cover, you must first open the right 
cover and the side door.

2 Remove the appropriate filter holder or mirror holder.

Follow the precautions outlined in Laser Safety on page xvii while changing 
optical filters or mirrors.
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3 Replace it with the new filter holder or mirror holder.

Tip     The filter and mirror holders fit easily into the slots only one way.

4 Close the cytometer cover(s).

Additional Optical Filters and Mirrors

See Additional Optics on page 128 for optical maps of some common custom 
filter and mirror configurations. The filters and mirrors used in these 
configurations are included with your spares kit (Table 2-1 on page 44).

Filter and Mirror Specifications

Table 2-1  Longpass dichroic mirrors in octagon or trigon

Specification Measurement

Diameter 0.625 in. +0.000, –0.005

Minimum clear aperture 0.562 in.

Incident angle 11.25°

Thickness 0.125 in. ±0.005 in.

Table 2-2  Bandpass filters in octagon or trigon

Specification Measurement

Diameter 1.00 in. ±0.010 in.

Minimum clear aperture 0.85 in.

Incident angle 0°

Thickness 0.12–0.35 in.
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Preparing Sheath and Waste Containers

Tip     Check the fluid levels in the sheath and waste containers every time you use 
the cytometer. This ensures that you do not run out of sheath fluid during an 
experiment and that the waste container does not become too full.

Figure 2-2  Sheath container

air line

filter

(to cytometer)
 

assembly

sheath fluid line

tank handle

cap handle

vent valve
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To prepare the sheath container:

1 Verify that the flow cytometer is in standby mode.

2 Disconnect the air line (green) from the sheath container.

3 Depressurize the sheath container by pulling up on the vent valve.

4 Remove the sheath container lid. Unscrew the clamp knob and lift.

5 Add 6 L of sheath fluid, such as BD FACSFlow solution, to the sheath 
container.

6 Replace the sheath container lid. 

7 Reconnect the air line (green).

8 Make sure that the lid is tightly sealed with the gasket in place, the clamp 
knob is finger-tight, and the cytometer fluid line (blue) is not kinked.

TIP Inspect the sheath container periodically, since sheath fluid can cause 
corrosion.

Do not fill the sheath tank to its maximum capacity (8 L). When an 
over-full tank is pressurized, erratic cytometer performance can result.
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Preparing the Waste Container

Figure 2-3  Waste container

All biological specimens and materials coming into contact with them are 
considered biohazardous. Handle as if capable of transmitting infection. 
Dispose of waste using proper precautions and in accordance with local 
regulations. Never pipette by mouth. Wear suitable protective clothing, 
eyewear, and gloves.

waste tubing
(from cytometer)

level sensor line

bracket
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To prepare the waste container:

1 Disconnect the orange waste tubing and the black level sensor line from the 
waste container. Keep the lid on the waste container until you are ready to 
empty it.

2 Empty the waste container.

3 Add approximately 1 L of bleach to the waste container and close it.

4 Reconnect the orange waste tubing and make sure it is not kinked.

5 Reconnect the level sensor line.

Preparing the Fluidics

Make sure the fluidics system is ready. This section describes the following 
preparations:

• Removing air bubbles

• Priming the fluidics

The waste container contents might be biohazardous. Treat contents with 
bleach (10% of total volume). Dispose of waste using proper precautions 
and in accordance with local regulations. Wear suitable protective clothing, 
eyewear, and gloves.
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Removing Air Bubbles

Trapped air bubbles in the sheath filter and the sheath line can occasionally 
dislodge and pass through the flow cell, resulting in inaccurate data.

Tip     Do not vigorously shake, bend, or rattle the sheath filter or you might 
damage it.

To remove air bubbles:

1 Check the sheath filter for trapped air bubbles.

2 If bubbles are visible, gently tap the filter body with your fingers to 
dislodge the bubbles and force them to the top.

3 Pinch the vent line closed (Figure 2-4 on page 50).

4 Loosen the sheath filter vent cap to bleed off any air in the filter. Collect the 
excess fluid in a container.

5 Replace the vent cap.

6 Check the sheath line for air bubbles.

7 Open the roller clamp at the fluidics interconnect (if necessary) to bleed off 
any air in the line. Collect any excess fluid in a waste container.

8 Close the roller clamp.
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Figure 2-4  Sheath filter

Priming the Fluidics

Sometimes, air bubbles and debris are stuck in the flow cell. This is indicated by 
excessive noise in the forward scatter parameter. In these cases, it is necessary to 
prime the fluidics system.

To prime the fluidics:

1 Remove the tube from the SIP.

2 Press the PRIME fluid control button to force the fluid out of the flow cell 
and into the waste container.

vent cap

vent line

cytometer fluid line
(roller clamp not visible)
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Once drained, the flow cell automatically fills with sheath fluid at a 
controlled rate to prevent bubble formation or entrapment. The STNDBY 
button turns amber after completion.

3 Repeat the priming procedure, if needed.

4 Install a 12 x 75-mm tube with 1 mL of DI water on the SIP and place the 
support arm under the tube. Leave the cytometer in standby mode.

Quality Control

A cytometer quality control (QC) procedure, performed on a regular basis, 
provides a standard for monitoring cytometer performance. Cytometer QC 
consists of running QC samples and recording the results.

QC results are affected by laser and fluidics performance. We strongly 
recommend following the laser and fluidics maintenance procedures (see 
Maintenance on page 77).

If you plan to manually set up and run QC procedures, see QC Particles on 
page 118 for a list of acceptable QC beads.

If you plan to use Cytometer Setup and Tracking, refer to the Cytometer Setup 
and Tracking Application Guide for information.
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3

Running Samples

This chapter describes procedures that use BD FACSDiva software to record and 
analyze sample data:

• Optimizing Your Cytometer on page 54

• Recording and Analyzing Data on page 67
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Before You Begin

Before you perform the procedures in this chapter, you should be familiar with:

• BD LSR II cytometer startup, setup, and QC procedures (see Cytometer 
Setup on page 39)

• BD FACSDiva software concepts: workspace components, cytometer and 
acquisition controls, tools for data analysis

To become familiar with BD FACSDiva software, perform the tutorial 
exercises in BD FACSDiva Software Quick Start Guide.

For additional details, refer to the BD FACSDiva Software Reference 
Manual.

Optimizing Your Cytometer

Before you record data for a sample, optimize the cytometer settings for the 
sample type and fluorochromes used. This section describes how to optimize the 
settings using the Compensation Setup feature of BD FACSDiva software. It does 
not use the CS&T application to generate the baseline settings. See the Cytometer 
Setup and Tracking Application Guide for information. 

Note that compensation setup automatically calculates compensation settings. If 
you select to perform compensation manually, not all of the following 
instructions apply. For detailed instructions, refer to the BD FACSDiva Software 
Reference Manual.

To optimize settings:

1 Prepare the workspace.

2 Optimize voltages and the threshold setting.

3 Record the compensation tubes.

4 Calculate compensation settings.
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The data shown in this example is from a 4-color bead sample with the following 
fluorochromes:

• FITC

• PE

• PerCP-Cy5.5

• APC

To perform this example exercise:

Prepare an unstained control tube and single-stained tubes for each 
fluorochrome.

If you follow this procedure with a different bead sample (or another sample 
type), your software views, data plots, and statistics might differ from the 
example. Additionally, you might need to modify some of the instructions in the 
procedure.

Preparing the Workspace

To prepare your workspace for running samples, you need to verify the cytometer 
configuration and your user preferences, and create a new experiment.

Verifying the Cytometer Configuration and User Preferences

To obtain accurate data results, the current cytometer configuration must reflect 
your BD LSR II cytometer optics. 
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To verify the configuration and preferences before you create an experiment:

1 Select Cytometer > View Configurations and verify the current 
configuration. 

Figure 3-1  Cytometer Configuration dialog

NOTICE     Your cytometer will include only one base configuration when 
your cytometer is installed. You can create additional configurations as 
needed at a later time. 

In the Configurations tab, select a configuration. For your bead sample, the 
cytometer configuration must include the following parameters: FITC, PE, 
PerCP-Cy5.5, and APC.

2 Click OK to close the dialog.

3 Select Edit > User Preferences. 
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4 Select the General tab and deselect all checkboxes except the Load data 
after recording checkbox.

Figure 3-2  User Preferences dialog

Refer to the BD FACSDiva Software Reference Manual for more information 
about cytometer configuration and user preferences.
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Setting Up an Experiment

In this section, you create an experiment in a new folder, specify the parameters 
of the experiment, and add compensation tubes.

To create an experiment:

1 Click the buttons on the Workspace toolbar to display windows as needed:

• Browser 

• Cytometer 

• Inspector 

• Worksheet  

• Acquisition Dashboard 

When you add elements or make selections in the Browser window, the 
Inspector window displays details, properties, and options that correspond 
to your selection.

2 Click the New Folder button ( ) on the Browser toolbar to add a new 
folder. 

3 Click the folder and rename it MyFolder.

4 Click MyFolder, then click the New Experiment button on the Browser 
toolbar, or right-click the new folder and select New Experiment from the 
menu. 

5 Click the new experiment in Browser and rename it MyExperiment.
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6 Select MyExperiment in the Browser. The Inspector displays details for 
MyExperiment. 

To specify the parameters for the new experiment:

1 Select Cytometer Settings for the experiment in the Browser.

2 Cytometer settings appear in the Inspector.

3 Make sure the parameters you need appear on the Parameters tab in the 
Inspector.

If more than one parameter is available for a particular PMT, you might 
have to select the one you need from a menu. For example, you can set 
Detector D for the blue laser as FITC or FP.

• Click the Parameter name to display the available fluorochromes in 
the Parameters list. 
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• Select the specific parameter from the drop-down list. Your 
selection appears as the selected parameter.

For this example, select FITC from the menu.

4 Delete any unnecessary parameters.
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• Click the selection button (on the left side of the pane) to select the 
parameter.

• Click Delete. The parameter is deleted.

To create compensation control tubes:

1 Select Experiment > Compensation Setup > Create Compensation Controls.

The Create Compensation Controls dialog appears. 

For this bead example, you do not need to provide non-generic tube labels. 
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Figure 3-3  Create Compensation Controls

2 Click OK to create the control tubes.

Compensation control tubes are added to the experiment. Worksheets 
containing appropriate plots and gates are added for each compensation 
tube.

Figure 3-4  Compensation tubes
62 BD LSR II User’s Guide  



Optimizing the Voltages and Threshold

In this section, you use the unstained control tube to adjust FSC and SSC voltages 
and FSC threshold to gate the population of interest (bead singlets, in this case), 
and to adjust fluorescence PMT voltages.

To optimize settings:

1 Press RUN and HI on the cytometer fluid control panel.

2 Install the unstained control tube onto the SIP. 

3 Expand the Compensation Controls specimen in the Browser.

4 Click to set the current tube pointer next to the unstained control tube (it 
becomes green), then click Acquire Data in the Acquisition Dashboard.

5 Adjust the FSC and SSC voltages to place the population on scale.

• Click the Parameters tab in the Cytometer window. 

• Use the up and down arrows or drag the voltage sliders to adjust the 
voltage settings.

6 Click the Threshold tab and adjust the FSC threshold, if needed.

Adjust the FSC threshold to remove most of the debris without clipping the 
singlet population.

7 Install the unstained control tube onto the SIP.

8 Adjust the P1 gate on the Unstained Control worksheet, as needed, to 
encompass only the singlet population. 
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Figure 3-5  P1 gate adjusted to singlet population

9 Right-click the gate and select Apply to All Compensation Controls.

The P1 gate on each Stained Control worksheet is updated with your 
changes.

10 Enter baseline PMT values, then verify that the positive sample is on scale. 
The baseline PMT voltage settings were established by performing the steps 
described in Establishing Optimum Baseline PMT Gains to Maximize 
Resolution on BD Biosciences Digital Flow Cytometers (Part No. 23-8359-
00).

NOTICE     If you significantly lower the PMT voltage below the original 
setting in order to bring the positive population on scale, the dim positive 
population might not be easily resolved from the negative population for 
that parameter.

11 Click Record Data. 

When all events have been recorded, remove the unstained control tube 
from the cytometer.

Do not change the PMT voltages after the first compensation control has 
been recorded. In order to calculate compensation, all controls must be 
recorded with the same PMT voltage settings. If you need to adjust the 
PMT voltage for a subsequent compensation control, you must record all 
compensation controls again.
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Calculating Compensation

Before you can calculate compensation, you need to record data for each single-
stained control.

To record data for each single-stained control:

1 Install the first stained control tube onto the SIP.

2 In the Acquisition Dashboard, click Next Tube, and then Acquire Data. 
You can also set the current tube pointer to the next tube and click the 
pointer to start acquisition.

3 Click Record Data, or Alt-click the current tube pointer to record data.

4 When recording is finished, install the next stained control tube onto the 
SIP.

5 Repeat steps 2 through 4 until data for all stained control tubes has been 
recorded.

6 Install a tube of DI water onto the SIP. Place the cytometer in standby 
mode. 

7 Double-click the first stained control tube (FITC stained control) to display 
the corresponding worksheet.

8 Verify that the snap-to interval gate surrounds the fluorescence-positive 
peak on the histogram. Adjust the gate, if needed.
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Figure 3-6  Gating the positive population

9 Repeat steps 7 and 8 for the remaining compensation tubes.

To calculate compensation:

1 Select Experiment > Compensation Setup > Calculate Compensation.

If the calculation is successful, a dialog is displayed where you can enter a 
name for the compensation setup.

2 Enter a setup name and click Link & Save. 

The compensation is linked to the cytometer settings and saved to the 
catalog.

Tip     To help track compensation setups, include the experiment name, date, 
or both in the setup name.

The compensation setup is linked to the MyExperiment cytometer settings, 
and subsequent acquisitions in MyExperiment are performed with the new 
compensation settings.

NOTICE     BD Biosciences recommends that you always visually and statistically 
inspect automatically calculated overlap values. The means of the positive 
controls should be aligned with the means of the negative.
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Recording and Analyzing Data

This section outlines some basic acquisition and analysis tasks using 
BD FACSDiva software. The example shows data from two 4-color bead samples 
with the following fluorochromes:

• FITC

• PE

• PerCP-Cy5.5

• APC

The procedure builds on the results obtained in the previous exercise: Optimizing 
Your Cytometer on page 54. 

To perform this procedure:

Prepare two tubes containing all four fluorochromes.

If you use a different sample type (or if you have skipped the optimization 
exercise), your software window content and your data plots and statistics might 
differ from those shown here. You might also need to modify some of the 
instructions in the procedure.

For additional details on completing some of the steps below, refer to the 
BD FACSDiva Software Reference Manual.
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Preparing the Workspace

In this section, you prepare your workspace before recording data.

To prepare the workspace:

1 Using the Browser toolbar, create a new specimen in MyExperiment and 
rename it FourColorBeads.

2 Create two tubes for the FourColorBeads specimen. Rename the tubes 
Beads_001 and Beads_002.

3 Expand the Global Worksheets folder in MyExperiment to access the 
default global worksheet, and rename the worksheet MyData.

4 On the MyData worksheet, create the following plots for previewing the 
data:

• FSC vs SSC

• FITC vs PE

• FITC vs PerCP-Cy5.5

• FITC vs APC

Tip     Double-click the Dot Plot button to keep the button selected until you 
create all plots.

Recording Data

In this section, you preview and record data for multiple samples.

To record data:

1 Press RUN and HI on the cytometer fluid control panel.

2 Install the first sample tube onto the SIP.
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3 Set the current tube pointer to Beads_001. 

4 Click Acquire Data in the Acquisition Dashboard to begin acquisition. 

5 While data is being acquired:

• Draw a gate around the singlets on the FCS vs SSC plot.

• Rename the P1 gate to Singlets.

• Use the Inspector to set the other plots to show only the singlet 
population by selecting the singlets checkbox.

6 Click Record Data.

7 When event recording has completed, remove the first tube from the 
cytometer. 

The MyData worksheet plots should look like the following figure.
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Figure 3-7  Recorded data showing singlet population

8 Install the second sample tube onto the SIP.

9 Set the current tube pointer to Beads_002.

10 Click Acquire Data to begin acquisition.

Before recording, preview the data on the MyData worksheet.

11 Click Record Data.

12 When event recording has completed, remove the second tube from the 
cytometer.

13 If you are recording more than two tubes, repeat steps 8 through 12 for the 
additional tubes.
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14 Print the experiment-level cytometer settings. Right-click the Cytometer 
Settings icon in the Browser and select Print.

15 Install a tube of DI water onto the SIP. Place the cytometer in standby 
mode.

Analyzing Data

In this section, you analyze the recorded tubes by creating plots, gates, a 
population hierarchy, and statistics views on a new global worksheet. When 
complete, your new global worksheet should look like Figure 3-8 on page 74.

To analyze data:

1 Use the Browser toolbar to create a new global worksheet. Rename it 
MyDataAnalysis.

2 Create the following plots on the MyDataAnalysis worksheet:

• FSC vs SSC

• FITC vs PE

• FITC vs PerCP-Cy5.5

• FITC vs APC

3 Create a population hierarchy and a statistics view, and set them below the 
plots on the worksheet.

• Right-click any plot and select Show Population Hierarchy. 

• Right-click any plot and select Create Statistics View. 

4 Set the current tube pointer to Beads_001.

5 Draw a gate around the singlets on the FSC vs SSC plot. 

6 Use the population hierarchy to rename the population Singlets.
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7 Select all plots except the FSC vs SSC plot, and use the Plot tab in the 
Inspector to specify to show only the singlet population.

8 Select all plots, and click the Title tab in the Inspector. Select the Tube and 
Populations checkboxes to display their names in plot titles.

9 On all fluorescence plots:

• Make all plots biexponential. Select all fluorescence plots and select the 
X Axis and Y Axis checkboxes in the Plot tab of the Inspector.

• Draw a gate around the FITC-positive population, for the first plot 
only, and name the population FITC positive in the population 
hierarchy.
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• Draw a gate around the PE-positive population, and name the 
population PE positive in the population hierarchy.

• Draw a gate around the PerCP-Cy5.5-positive population, and name 
the population PerCP-Cy5.5 positive in the population hierarchy.

• Draw a gate around the APC-positive population, and name the 
population APC positive in the population hierarchy.

10 Format the statistics view.

• Right-click the statistics view and select Edit Statistics View.

• Click the Header tab and select the Specimen Name and Tube Name 
checkboxes.

• Click the Populations tabs and select all populations except All Events. 
Deselect the %Parent, %Total, and #Events checkboxes.

• Click the Statistics tab and select the mean for each of the fluorescence 
parameters.

• Click OK.
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11 Print the analysis.

Your global worksheet analysis objects should look like the following 
figure.

Figure 3-8  Bead analysis
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Reusing the Analysis

Global worksheets allow you to apply the same analysis to a series of recorded 
tubes. Once you define an analysis for a tube, you can use it to analyze the 
remaining tubes in the experiment. After viewing the data, print the analysis or 
save it to a tube-specific worksheet (see Saving the Analysis).

To reuse the analysis:

1 Set the current tube pointer to the tube Beads_002.

2 View the Beads_002 data on your analysis worksheet. Adjust the gates as 
needed.

Tip     Adjustments apply to subsequent tubes viewed on the worksheet. 
Avoid altering a global worksheet by saving an analysis to a tube-specific 
worksheet, then making adjustments on the tube-specific worksheet.

3 Print the analysis.

Saving the Analysis

When you perform analysis with a global worksheet, the analysis does not save 
with the tube.

Tip     If you define your analysis on a global worksheet before recording data, you 
can specify to automatically save the analysis after recording data. You set this 
option in User Preferences.
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To save a copy of the analysis of Beads_001 with that tube:

1 Expand the MyDataAnalysis global worksheet icon in the Browser.

2 Right-click its analysis and select Copy.

3 Click the Worksheets View button ( ) on the Worksheet toolbar to switch 
to the normal worksheet view.

4 Select Worksheet > New Worksheet to create a new normal worksheet.

5 Right-click the Beads_001 tube icon in the Browser, and select Paste.

The analysis objects from the MyDataAnalysis global worksheet are copied 
to the Beads_001_Analysis normal worksheet. Double-click the Beads_001 
tube in the Browser to view the analysis.

Tip     Apply the global worksheet analysis to multiple tubes (on a single 
normal worksheet) by selecting more than one tube before you paste the 
analysis. Ensure that you collapse all tube elements in the Browser before 
you paste them to multiple tubes.
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4

Maintenance

• Maintaining the Cytometer on page 78

• Daily Cleaning and Shutdown on page 78

• Scheduled Maintenance on page 80

• Periodic Maintenance on page 85
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Maintaining the Cytometer

The BD LSR II cytometer is designed to require minimum maintenance. 
However, to preserve the reliability of the cytometer, you must regularly perform 
basic preventive maintenance procedures. This chapter explains routine cleaning 
procedures that keep your cytometer in good condition.

Tip     A 5% solution of sodium hypochlorite can be substituted for undiluted 
bleach in the following cleaning procedures. However, higher concentrations of 
sodium hypochlorite and use of other cleaning agents might damage the 
cytometer.

Daily Cleaning and Shutdown

Perform the following maintenance procedures every day:

• Daily Fluidics Cleaning on page 78

• Daily Shutdown on page 80

Daily Fluidics Cleaning

Each time you shut down the cytometer, clean the sample injection tube and the 
area between the injection tube and the outer sleeve. This prevents the sample 
injection tube from becoming clogged and removes dyes that can remain in the 
tubing.

All biological specimens and materials coming into contact with them are 
considered biohazardous. Handle as if capable of transmitting infection. 
Dispose of waste using proper precautions and in accordance with local 
regulations. Never pipette by mouth. Wear suitable protective clothing, 
eyewear, and gloves.
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Tip     Follow this procedure immediately after running viscous samples or nucleic 
acid dyes such as Hoechst, DAPI, propidium iodide (PI), acridine orange (AO), or 
thiazole orange (TO).

To clean the fluidics:

1 Press RUN and HI on the cytometer fluid control panel. 

2 Install a tube containing 3 mL of a bleach solution on the SIP with the 
support arm to the side (vacuum on) and let it run for 1 minute.

Tip     For the bleach solution, use BD™ FACSClean solution or a 1:10 
dilution of bleach in DI water.

BD FACS cleaning solution is a bleach-based cleaning agent designed for 
daily use in cytometer maintenance.

3 Move the tube support arm under the tube (vacuum off) and allow the 
bleach solution to run for 5 minutes with the sample flow rate set to HI.

4 Repeat steps 2 and 3 with BD™ FACSRinse solution.

BD FACSRinse solution is a detergent-based cleaning solution.

5 Repeat steps 2 and 3 with DI water.

6 Press the STNDBY button on the fluidics control panel.

7 Place a tube containing no more than 1 mL of DI water on the SIP.

A tube with 1 mL of DI water should remain on the SIP to prevent salt 
deposits from forming in the injection tube. This tube also catches back 
drips from the flow cell.

Tip     Do not leave more than 1 mL of water on the SIP. When the BD LSR II 
flow cytometer is turned off or left in STNDBY mode, a small amount of 
fluid will drip back into the sample tube. If there is too much fluid in the 
tube, it could overflow and affect cytometer performance.
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Daily Shutdown

To shut down the cytometer:

1 Turn off the flow cytometer.

2 Select Start > Shutdown to turn off the computer (if needed).

Tip     If the cytometer will not be used for a week or longer, perform a system flush 
(see System Flush on page 80) and leave the fluidics system filled with DI water to 
prevent saline crystals from clogging the fluidics.

Scheduled Maintenance

Perform the following maintenance procedures every 2 weeks:

• System Flush on this page

• Waste Management System Maintenance on page 82

System Flush

An overall fluidics cleaning is required to remove debris and contaminants from 
the sheath tubing, waste tubing, and flow cell. Perform the system flush at least 
every 2 weeks.

Cytometer hardware might be contaminated with biohazardous material. 
Use 10% bleach to decontaminate the BD LSR II flow cytometer. 
Flushing with 10% bleach is the only procedure recommended by BD 
Biosciences for decontaminating the cytometer.
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To perform a system flush:

1 Remove the sheath filter.

• Press the quick-disconnects on both sides of the filter assembly.

• Remove the filter assembly.

• Connect the two fluid lines.

Tip     Do not run detergent, bleach, or ethanol through the sheath filter. They 
can break down the filter paper within the filter body, causing particles to 
escape into the sheath fluid, possibly clogging the flow cell.

2 Empty the sheath container and rinse it with DI water.

3 Fill the sheath container with at least 1 L of a 1:10 dilution of bleach or 
full-strength BD FACS cleaning solution.

4 Empty the waste container, if needed.

5 Open the roller clamp by the fluidics interconnect, and drain the fluid into 
a beaker for 5 seconds.

6 Remove the DI water tube from the SIP.

7 Prime twice (perform the following twice):

• Press the PRIME button on the fluidics control panel. 

• When the STNDBY button lights (amber), press the PRIME button 
again.

8 Install a tube with 3 mL of a 1:10 dilution of bleach or full-strength 
BD FACS cleaning solution on the SIP.

9 Press RUN and HI on the cytometer fluid control panel. Run for 30 
minutes.
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10 Press the STNDBY fluid control button and depressurize the sheath 
container by lifting the vent valve.

11 Repeat steps 2 through 10 with BD FACSRinse solution in place of the 
bleach solution.

12 Repeat steps 2 through 10 with DI water in place of the BD FACSRinse 
solution.

13 Replace the sheath filter and refill the sheath container with sheath fluid.

Waste Management System Maintenance

The waste management system for the BD LSR II cytometer has an alarm 
powered by a 9-volt battery that you must test and change regularly to ensure 
continued operation. Test the battery every 2 weeks after you flush the system. 
Change the battery as needed. See Changing the Battery on page 83 for more 
information.

Testing the Battery and Alarm

To test the battery and alarm:

1 Locate the Battery Test switch on the waste container bracket.
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Figure 4-1  Battery Test switch

2 Toggle the switch.

If the battery and the alarm are working properly, you should hear buzzing. 
If you do not hear any sound, change the battery as described in the 
following section.

3 Release the switch.

Changing the Battery

You need the following supplies to change the battery:

• small flat-head screwdriver

• 9-volt battery
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To change the battery:

1 Insert the tip of a flat-head screwdriver into the slot and gently slide the 
battery drawer out.

Figure 4-2  Battery drawer

2 Remove the drawer.

3 Remove the battery from the drawer.
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4 Place a new 9-volt battery into the drawer. The markings in the battery 
drawer show the correct battery orientation.

5 Slide the drawer into the bracket until you feel a click.

6 Test the new battery. 

See Testing the Battery and Alarm on page 82.

Periodic Maintenance

You should check the following cytometer components occasionally and clean 
them as necessary. The frequency depends on how often you run the cytometer. 
You should check other components periodically for wear and replace if 
necessary.

• Changing the Sheath Filter on page 85

• Changing the Bal Seal on page 88

• Changing the Sample Tube O-Ring on page 90

Changing the Sheath Filter

The sheath filter (Figure 4-3) is connected in-line with the sheath line. It filters the 
sheath fluid as it comes from the sheath container. Increased debris appearing in 
an FSC vs SSC plot can indicate that the sheath filter needs to be replaced. We 
recommend changing the sheath filter assembly every 3–6 months.
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Figure 4-3  Sheath filter

Removing the Old Filter

To remove the old filter:

1 Place the cytometer in standby mode.

2 Remove the sheath filter assembly by pressing the quick-disconnect on both 
sides of the filter assembly.

3 Over a sink or beaker:

- Remove the vent line from the filter and set it aside.

- Remove the filter base and set it aside.

4 Discard the used filter assembly in an appropriate receptacle.

vent line

vent cap

sheath line

quick-disconnect

filter base
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Attaching the New Filter

To attach the new filter:

1 Connect the vent line to the new filter assembly.

Twist to attach.

2 Connect the filter base to the filter.

Tip     Wrap Teflon® tape around the filter threads before connecting the 
filter to the base.

3 Connect the sheath line to the filter assembly by squeezing the quick-
disconnect.

4 Attach the cytometer fluid line to the filter assembly via the quick-
disconnect.

5 Loosen the filter’s vent cap to bleed off any air in the sheath filter.

6 Carefully tap the filter assembly to dislodge any air trapped in the filter 
element.

7 Repeat steps 5 and 6 as necessary to remove all trapped air.
Chapter 4: Maintenance 87



Changing the Bal Seal

The sample injection tube Bal seal is a ring that forms a seal with the sample tube 
and ensures proper tube pressurization. Over time, the Bal seal becomes worn or 
cracked and requires replacement. Replacement is necessary if a proper seal is not 
formed when a sample tube is installed on the SIP.

Tip     Indications that a proper seal has not formed include:

• The tube will not stay on the SIP without the tube support arm.

• The tube is installed, RUN is pressed on the cytometer, and the RUN 
button is orange (not green).

To replace the Bal seal:

1 Remove the outer sleeve from the sample injection tube by turning the 
retainer counterclockwise.

Figure 4-4  Removing the outer sleeve

NOTICE     Work carefully—the outer sleeve can fall out as you loosen the retainer.

2 Remove the Bal seal by gripping it between your thumb and index finger 
and pulling down.

outer sleeve

sample injection tube

retainerBal seal
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Figure 4-5  Removing the Bal seal

3 Install the new Bal seal spring-side up.

Gently push the seal in place to seat it.

4 Re-install the retainer and outer sleeve over the sample injection tube. 
Tighten the retainer just enough to hold it in place.

5 Install a sample tube on the SIP to ensure that the outer sleeve has been 
properly installed. If the sleeve hits the bottom of the tube, loosen the 
retainer slightly and push the sleeve up as far as it will go. Tighten the 
retainer.
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Changing the Sample Tube O-Ring

The sample tube O-ring, located within the retainer, forms a seal that allows the 
droplet containment vacuum to function properly. Replace the O-ring when 
droplets form at the end of the sample injection tube while the vacuum is 
operating.

To change the O-ring:

1 Remove the outer droplet sleeve from the sample injection tube by turning 
the retainer counterclockwise.

2 Pull the outer sleeve from the retainer.

3 Invert the retainer and allow the O-ring to fall onto the benchtop. If the 
O-ring does not fall out initially, tap the retainer on the benchtop to 
dislodge the O-ring.

4 Place the new O-ring into the retainer. Make sure the O-ring is seated 
properly in the bottom of the retainer.

5 Replace the outer sleeve into the retainer.

6 Re-install the retainer and the outer sleeve.

7 Install a sample tube on the SIP to ensure that the outer sleeve has been 
properly installed. If the sleeve hits the bottom of the tube, loosen the 
retainer slightly and push the sleeve up as far as it will go. Tighten the 
retainer.

Cytometer hardware might be contaminated with biohazardous material. 
Wear suitable protective clothing, eyewear, and gloves whenever cleaning 
the cytometer or replacing parts.
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Appendix A

Technical Overview

This appendix contains a technical overview of the following topics:

• Fluidics on page 92

• Optics on page 93

• Electronics on page 102
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Fluidics

The fluidics system in the BD LSR II flow cytometer is pressure driven—a built-in 
air pump provides a sheath pressure of 5.5 psi. After passing through the sheath 
filter, sheath fluid is introduced into the lower chamber of the quartz flow cell.

The sample to be analyzed arrives in a separate pressurized stream. When a 
sample tube is placed on the sample injection port (SIP), the sample is forced up 
and injected into the lower chamber of the flow cell by a slight overpressure 
relative to the sheath fluid. The conical shape of the lower chamber creates a 
laminar sheath flow that carries the sample core upward through the center of 
the flow cell, where the particles to be measured are intercepted by the laser beam 
(Figure A-1 on page 93). This process is known as hydrodynamic focusing.

The objective in flow cytometric analysis is to have at most one cell or particle 
moving through a laser beam at a given time. The difference in pressure between 
the sample stream and sheath fluid stream can be used to vary the diameter of the 
sample core. Increasing the sample pressure increases the core diameter and 
therefore the flow rate (Figure A-1 on page 93).

• A higher flow rate is generally used for qualitative measurements such as 
immunophenotyping. The data is less resolved but is acquired more 
quickly.

• A lower flow rate is generally used in applications where greater resolution 
and quantitative measurements are critical, such as DNA analysis.

Proper operation of fluidic components is critical for particles to intercept the 
laser beam properly. Always ensure that the fluidics system is free of air bubbles 
and debris, and is properly pressurized.
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Figure A-1  Hydrodynamic focusing of the sample core through the flow cell

Optics

The optics system consists of lasers, optical filters, and detectors. Lasers 
illuminate the cells or particles in the sample and optical filters direct the 
resulting light scatter and fluorescence signals to the appropriate detectors.

Light Scatter

When a cell or particle passes through a focused laser beam, laser light is 
scattered in all directions (Figure A-2 on page 94). Light that scatters axial to the 
laser beam is called forward scatter (FSC); light that scatters perpendicular to the 
laser beam is called side scatter (SSC). FSC and SSC are related to certain physical 
properties of cells:

• FSC—indicates relative differences in the size of the cells or particles

• SSC—indicates relative differences in the internal complexity or granularity 
of the cells or particles
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Figure A-2  Forward scatter (FSC) and side scatter (SSC)

Fluorescence

When cells or particles stained with fluorochrome-conjugated antibodies or other 
dyes pass through a laser beam, the dyes can absorb photons (energy) and be 
promoted to an excited electronic state. In returning to their ground state, the 
dyes release energy, most of which is emitted as light. This light emission is 
known as fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) than the 
excitation wavelength. The difference between the excitation wavelength and the 
emission wavelength is known as the Stokes shift. Some fluorescent compounds 
such as PerCP exhibit a large Stokes shift, absorbing blue light (488 nm) and 
emitting red light (675 nm), while other fluorochromes such as FITC have a 
smaller Stokes shift, absorbing blue light and emitting green light (530 nm).

The emission spectra for some commonly used fluorochromes are shown in 
Figure A-3 on page 95.

light source

side scatter

forward scatter
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Figure A-3  Emission spectra of commonly used fluorochromes 

Optical Filters

Optical filters modify the spectral distribution of light scatter and fluorescence   
directed to the detectors. When photons encounter an optical filter, they are 
either transmitted, absorbed, or reflected (Figure A-4).

Figure A-4  Effect of an optical filter on incident photons
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Even though an optical filter is rated at its 50% transmission point, the filter 
passes—or lets through—a minimal amount of light outside of this indicated 
rating.

The slope of an optical filter transmission curve indicates filter performance. 
A relatively steep slope indicates a high-performance, high-quality optical filter 
that provides deep attenuation of out-of-band wavelengths. A less steep slope 
indicates that more light outside the rated bandwidth is being transmitted.

Two kinds of filters are used on the BD LSR II flow cytometer:

• longpass (LP)

• bandpass (BP), including discriminating filters (DF) and ALPHA filters 
(AF)

A third filter type, the shortpass (SP), is not recommended, but can be used in 
some custom configurations. See Shortpass Filters on page 97.

LP, BP, and SP filters are referred to as dichroic filters. See Dichroic Mirrors on 
page 99.

Longpass Filters 

LP filters pass wavelengths longer than the filter rating. For example, a 500-LP 
filter permits wavelengths longer than 500 nm to pass through it and either 
absorbs or reflects wavelengths shorter than 500 nm.
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Shortpass Filters

An SP filter has the opposite properties of a longpass filter. An SP filter passes 
light with a shorter wavelength than the filter rating.

Bandpass Filters 

A BP filter transmits a relatively narrow range or band of light. Bandpass filters 
are typically designated by two numbers. The first number indicates the center 
wavelength and the second refers to the width of the band of light that is passed. 
For example, a 500/50 BP filter transmits light that is centered at 500 nm and has 
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a total bandwidth of 50 nm. Therefore, this filter transmits light between 475 
and 525 nm.

Figure A-5  Bandpass filter

BP and DF filters have the same general function—they transmit a relatively 
narrow band of light. The principal difference between them is their 
construction. DF filters have more cavities or layers of optical coatings, resulting 
in a steeper transmission curve than the curve for a BP filter. This steep slope 
means that a DF filter is better at blocking light outside the rated bandwidth of 
the filter. 
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Dichroic Mirrors

Dichroic filters that are used to direct different color light signals to different 
detectors are called dichroic mirrors or beam splitters.

Although dichroic mirrors have the properties of LP or SP optical filters, you can 
not necessarily use any type of LP or SP filter as a beam splitter. A beam splitter 
must have a surface coating that reflects certain wavelengths, but many LP or SP 
filters are absorbance filters that do not have any specific reflective 
characteristics. Also, optical filters and beam splitters are rated at a specific angle 
of incidence. When used in front of the fluorescence detectors, they are 
perpendicular to the incident light, and when used as a beam splitter, they are 
placed at an angle relative to the light source. Their optical properties are 
therefore designed for that angle of incidence.

Compensation Theory

Fluorochromes emit light over a range of wavelengths (Figure A-3 on page 95). 
Optical filters are used to limit the range of frequencies measured by a given 
detector. However, when two or more fluorochromes are used, the overlap in 
wavelength ranges often makes it impossible for optical filters to isolate light 
from a given fluorochrome. As a result, light emitted from one fluorochrome 
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appears in a detector intended for another (Figure A-6). This is referred to as 
spillover. Spillover can be corrected mathematically by using a method called 
compensation.

Figure A-6  Spillover from the FITC fluorochrome to the PE detector

For example, FITC emission appears primarily in the FITC detector, but some of 
its fluorescence spills over into the PE detector. The spillover is corrected or 
compensated for—hence the term fluorescence compensation.

Figure A-6 shows that some of the FITC emission appears in the PE detector. 
This can be seen in a dot plot of FITC vs PE.

Figure A-7  Theoretical display of FITC vs PE without compensation
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This FITC spillover in the PE detector is to be corrected as indicated by the arrow 
in Figure A-7. Using the Compensation tab of the Cytometer window in 
BD FACSDiva software, you can adjust the PE-%FITC spectral overlap value. 
Compensation is optimal when the positive and negative FITC populations have 
the same means or medians in the PE parameter statistics.

Figure A-8  FITC spillover optimally compensated out of the PE parameter

Once fluorescence compensation has been set for any sample, the compensation 
setting remains valid for a subsequent dim or bright sample, because 
compensation subtracts a percentage of the fluorescence intensity. Figure A-9 
illustrates this principle. Although the signals differ in intensity, the percentage of 
the FITC spillover into the PE detector remains constant.
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Figure A-9  Two FITC signals of different intensity

Electronics

As cells or other particles pass through a focused laser beam, they scatter the 
laser light and can emit fluorescence. Because the laser beam is focused on a small 
spot and particles move rapidly through the flow cell, the scatter or fluorescence 
emission has a very brief duration—only a few microseconds. This brief flash of 
light is converted into an electrical signal by the detectors. The electrical signal is 
called a pulse.

1 A pulse begins when a particle enters the laser beam. At this point, both the 
beam intensity and signal intensity are low.

2 The pulse reaches a maximum intensity or height when the particle reaches 
the middle of the beam, where the beam and signal intensity are the 
brightest. The peak intensity, or height of the pulse, is measured at this 
point.

3 As the particle leaves the beam, the pulse trails off below the threshold.
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Figure A-10  Anatomy of a pulse
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Pulse Measurements

The pulse processors measure pulses by three characteristics: height, area, and 
width.

Figure A-11  Pulse measurements

• Pulse height is the maximum digitized intensity measured for the pulse.

• Pulse area is an integration of the digitized measures over time.

• Pulse width calculates: 
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Digital Electronics

BD LSR II flow cytometer electronics digitize the signal intensity produced by a 
detector. The digitized data is stored in memory and further processed by the 
electronics to calculate

• Pulse height, area, and width

• Compensation

• Parameter ratios

These results are transferred to your workstation computer for further processing 
by BD FACSDiva software. For more information about digital theory, refer to 
Digital Theory in the BD FACSDiva Software Reference Manual. 

Threshold

The threshold is the level at which the system starts to measure signal pulses. 
A threshold is defined for a specific detector signal. The system continuously 
samples the digitized signal data and calculates pulse area, height, and width for 
all channels based on the time interval during which the threshold is exceeded.

Thresholds can also be set for more than one parameter, and pulse measures are 
based on either of the following:

• Intervals during which ALL signals exceed their threshold value

• Intervals during which ANY signal exceeds its threshold value
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Laser Controls

Controls in the Laser tab of the Cytometer window are used to manually set the 
(laser) delay, area scaling, and window extension values.

These parameters are set by BD Biosciences service personnel during the 
BD LSR II flow cytometer installation and performance check and are updated 
each time you run a performance check.

If needed, see Optimizing Laser Delay on page 157 for instructions on manually 
adjusting laser delay settings. Do not otherwise change the settings in the Laser 
tab unless instructed to do so by BD Biosciences. Changing the settings affects 
your data.
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Appendix B

Troubleshooting

The tips in this section are designed to help you troubleshoot your experiments. 
You can find additional troubleshooting information in the BD FACSDiva 
Software Reference Manual.

If additional assistance is required, contact your local BD Biosciences technical 
support representative. See Technical Assistance on page xv.
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Cytometer Troubleshooting

Observation Possible Causes Recommended Solutions

Droplet containment 
vacuum not functioning

Worn O-ring in retainer Replace the O-ring. See Changing 
the Sample Tube O-Ring on 
page 90.

Outer sleeve is not seated in 
the retainer

1 Loosen the retainer (Figure 4-4 
on page 88).

2 Push the outer sleeve up into 
the retainer until seated.

3 Tighten the retainer.

Outer sleeve is not on the 
sample injection tube

Replace the outer sleeve.

1 Loosen the retainer.

2 Slide the outer sleeve over the 
sample injection tube until it is 
seated.

3 Tighten the retainer.

Waste line is pinched, 
preventing proper aspiration

Check the waste line.

Waste tank is full Empty the waste tank.

Sample tube not fitting 
on SIP

Sample tube other than 
BD Falcon tubes used

Use BD Falcon 12 x 75-mm 
sample tubes. See Equipment on 
page 120.

Worn Bal seal Replace the Bal seal. See Changing 
the Bal Seal on page 88.

Rapid sample aspiration Support arm is to the side Place the support arm under the 
sample tube.

Droplet containment module 
is failing

Call your service representative.
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No events in acquisition 
display and RUN button 
is green.

Threshold is not set to the 
correct parameter (usually 
FSC)

Set the threshold to the correct 
parameter for your application.

Threshold level is too high Lower the threshold level. 

PMT voltage for threshold 
parameter is set too low

Set the PMT voltage higher for the 
threshold parameter. 

Gating issue Refer to the BD FACSDiva 
Software Reference Manual for 
information on setting gates.

Air in the sheath filter Purge the filter. See Removing Air 
Bubbles on page 49.

No sample in the tube Add sample to the tube or install a 
new sample tube.

Sample is not mixed properly Mix the sample to suspend cells.

Waste tank is full Empty the waste tank.

PMT voltages set too low or 
too high for display 
parameter

Reset the PMT voltages.

Too few events are displayed Increase the number of events to 
display.

Sample injection tube is 
clogged

Remove the sample tube to allow 
backflushing.

If the event rate is still erratic, 
clean the sample injection tube. 
See Daily Cleaning and Shutdown 
on page 78.

Bal seal is worn Replace the Bal seal. See Changing 
the Bal Seal on page 88.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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No events in acquisition 
display and RUN button 
is green (continued)

Laser is not warmed up Wait the recommended amount of 
time for the laser to warm up.

• 30 min for the 488-nm (blue) 

• 30 min for the 355-nm (UV)

• 15 min for the 405-nm (violet)

• 20 min for the 633-nm (red)

Laser delay is set incorrectly Adjust the laser delay settings.

See Setting Laser Delay on 
page 155.

Laser is not functioning Verify the malfunction by 
changing the threshold to an 
alternative laser while running the 
appropriate sample. If 
unsuccessful, contact 
BD Biosciences.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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No events in acquisition 
display and RUN button 
is orange

RUN is not activated Press the RUN button.

Sample tube is not installed 
or is not properly seated

Install the sample tube correctly 
on the SIP.

Sample tube is cracked Replace the sample tube.

Sheath container is not 
pressurized

• Ensure that the sheath 
container lid and all connectors 
are securely seated.

• Inspect the O-ring and replace 
it if necessary. See Changing the 
Sample Tube O-Ring on 
page 90.

Bal seal is worn Replace the Bal seal. See Changing 
the Bal Seal on page 88.

Air leak at sheath container Ensure that the sheath container 
lid and all connectors are securely 
seated.

No events in acquisition 
display and RUN button 
is orange (continued)

Sheath container is empty Fill the sheath container.

Air in sheath filter Purge the filter. See Removing Air 
Bubbles on page 49.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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No fluorescent signal Incorrect fluorochrome 
assignment

Make sure the cytometer 
configuration in the software 
matches the optical filters in the 
cytometer.

Wrong filter is installed Make sure the appropriate filter is 
installed for each fluorochrome. 
See Changing Optical Filters or 
Mirrors on page 43.

Laser is not functioning Verify the laser malfunction by 
changing the threshold to an 
alternative laser while running the 
appropriate sample. If 
unsuccessful, contact 
BD Biosciences.

High event rate Air bubble in the sheath filter 
or flow cell

Remove the air bubble. See 
Removing Air Bubbles on 
page 49.

Threshold level is too low Increase the threshold level. Refer 
to the BD FACSDiva Software 
Reference Manual for 
instructions.

PMT voltage for the 
threshold parameter set too 
high

Set the PMT voltage lower for the 
threshold parameter. Refer to the 
BD FACSDiva Software 
Reference Manual for 
instructions.

Sample is too concentrated Dilute the sample.

Sample flow rate is set on HI Set the sample flow rate to MED 
or LO.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Low event rate Threshold level is too high Lower the threshold level. Refer to 
the BD FACSDiva Software 
Reference Manual for 
instructions.

PMT voltage for the 
threshold parameter is set too 
low

Set the PMT voltage higher for the 
threshold parameter. Refer to the 
BD FACSDiva Software 
Reference Manual for 
instructions.

Sample is not adequately 
mixed

Mix the sample to suspend the 
cells.

Sample is too diluted Concentrate the sample. If the 
flow rate setting is not critical to 
the application, set the flow rate 
switch to MED or HI.

Sample injection tube is 
clogged

Remove the sample tube to allow 
backflushing.

If the event rate is still erratic, 
clean the sample injection tube. 
See Daily Cleaning and Shutdown 
on page 78.

Erratic event rate Sample tube is cracked Replace the sample tube.

Bal seal is worn Replace the Bal seal. See Changing 
the Bal Seal on page 88.

Sample injection tube is 
clogged

Remove the sample tube to allow 
backflushing.

If the event rate is still erratic, 
clean the sample injection tube. 
See Daily Cleaning and Shutdown 
on page 78.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Erratic event rate 
(continued)

Sample injection tube is 
clogged

Remove the sample tube to allow 
backflushing.

If the event rate is still erratic, 
clean the sample injection tube. 
See Daily Cleaning and Shutdown 
on page 78.

Contaminated sample Prepare the specimen again. 
Ensure that the tube is clean.

Sheath filter is dirty Replace the filter. See Changing 
the Sheath Filter on page 85.

Distorted scatter 
parameters

Cytometer settings are 
improperly adjusted

Optimize the scatter parameters. 
Refer to the BD FACSDiva 
Software Reference Manual for 
instructions.

Air bubble in sheath filter or 
flow cell

Purge the air from the filter. See 
Removing Air Bubbles on 
page 49.

Flow cell is dirty Perform the system flush 
procedure. See System Flush on 
page 80.

Air leak at sheath container Ensure that the sheath container 
lid is tight and all connectors are 
secure.

Hypertonic buffers or fixative Replace the buffers and fixative.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Excessive amount of 
debris in display

Threshold level is too low Increase the threshold level.

Sheath filter is dirty Replace the filter. See Changing 
the Sheath Filter on page 85.

Flow cell is dirty Flush the system. See System Flush 
on page 80.

Dead cells or debris in sample Examine the sample under a 
microscope.

Sample is contaminated Re-stain the sample, ensure tube is 
clean.

Stock sheath fluid is 
contaminated

Rinse the sheath container with DI 
water, then fill with sheath fluid 
from another (or new lot) bulk 
container.

High CV Air bubble in sheath filter or 
flow cell

Purge the filter. See Removing Air 
Bubbles on page 49.

Sample flow rate is set too 
high

Set the sample flow rate lower.

Air leak at sheath container Ensure that the sheath container 
lid is tight and all connectors are 
secure.

Flow cell is dirty Flush the system. See System Flush 
on page 80.

Poor sample preparation Repeat sample preparation.

Sample not diluted in same 
fluid as sheath fluid

Dilute the sample in the same fluid 
as you are using for sheath.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Poor QC results Air bubble or debris in flow 
cell

Prime the fluidics system. See 
Priming the Fluidics on page 50.

Old or contaminated QC 
particles

Make new QC samples and 
perform the quality control 
procedure again.

Sample not diluted in same 
fluid as sheath fluid

Dilute the sample in the same fluid 
as you are using for sheath. 

Laser not warmed up Wait the recommended amount of 
time for the laser to warm up.

• 30 min for the 488-nm (blue) 

• 30 min for the 355-nm (UV)

• 15 min for the 405-nm (violet)

• 20 min for the 633-nm (red)

Laser not functioning Contact BD Biosciences.

Optical alignment problem Contact BD Biosciences.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Appendix C

Supplies and Consumables

To order spare parts and consumables, such as bulk fluids, from BD Biosciences:

• Within the US, call (877) 232-8995.

• Outside the US, contact your local BD Biosciences customer support 
representative.

Worldwide contact information can be found at bdbiosciences.com.

Use the following part numbers to order supplies for your BD LSR II system:

• QC Particles on page 118

• QC Cytometer Setup and Tracking Particles on page 118

• Reagents on page 119

• Equipment on page 120
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QC Particles 

QC Cytometer Setup and Tracking Particles

Particle Laser Supplier Catalog No.

• SPHERO™ 
Rainbow 
Calibration Particles
(8 peak)

• SPHERO Ultra 
Rainbow 
Fluorescent Particles 
(single peak)

• all

• all

• BD Biosciences

• Spherotech, Inc.

• 559123

• URFP-
30-2

DNA QC Particles kit blue 488 nm BD Biosciences 349523

Particle Laser Supplier

BD Cytometer Setup 
and Tracking beads

• UV (355 nm and 375 nm)

• violet (405 nm and 407 nm)

• blue (488 nm)

• green (532 nm)

• red (633 nm and 645 nm)

BD Biosciences 
(contact BD 
Biosciences for more 
information)
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Reagents

Reagent Supplier Catalog No.

BD FACSFlow sheath fluid BD Biosciences 340398
(US and Latin 

America)

342003
(Europe)

Monoclonal antibodies BD Biosciences –a

a. Refer to the BD Biosciences Product Catalog or the BD Biosciences website (bdbiosciences.com).

BD FACS™ lysing solution BD Biosciences 349202

BD FACSRinse solution BD Biosciences 340346

BD FACSClean solution BD Biosciences 340345

Dyes and fluorochromes BD Biosciences

Molecular Probes

Sigma

–

Chlorine bleach (5% sodium 
hypochlorite)

Clorox or other major 
supplier (to ensure that 
the bleach is at the 
correct concentration 
and free of particulate 
matter)

–
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Equipment

Equipment Item Supplier Catalog No.

Bal seal BD Biosciences 343509

O-ring, sample tube 343615

Sheath filter assembly 344678

BD FalconTM polystyrene test 
tubes, 12 x 75-mm 

 352052
352054
352058
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Appendix D

Standard Base Configuration

The standard base configuration for a BD LSR II cytometer supports detectors, 
filters, and mirrors for one to four lasers. This appendix describes how to set up 
the cytometer optics using standard default configuration components.

• 4-Blue 2-Violet 2-355 UV 2-Red Configuration on page 122

• Additional Optics on page 128

The BD LSR II cytometer can also be ordered with one of several optional 
configurations, which are described in Appendix E.
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4-Blue 2-Violet 2-355 UV 2-Red Configuration 

The standard configuration supports a blue octagon, and violet, UV, and red 
trigons. Table D-1 shows the detectors, filters, and mirrors used in the standard 
default configuration, and recommended fluorochromes for each detector. The 
word “blank” indicates that a blank optical holder should be used instead of a 
mirror or filter. A dash (—) indicates that no slot exists for a mirror in that PMT 
position. 

Table D-1  Default filters and fluorochromes

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 735 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 550 LP 575/26 PE, PI

D 505 LP 530/30 FITC, GFP

E blank 488/10 SSC

F blank blank none

G blank blank none

H — blank none

violet trigon 
(405-nm laser)

A 505 LP 525/50 AmCyan

B blank 440/40 Pacific Blue™

C — blank none

UV trigon 
(355-nm laser)

A 505 LP 530/30 Indo-1 (Blue)

B blank 450/50 Indo-1 (Violet), DAPI

C — blank none
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Base Configuration

Figure D-1 shows a default base cytometer configuration.

red trigon 
(633-nm laser)

A 735 LP 780/60 APC-Cy7

B blank 660/20 APC

C — blank none

Table D-1  Default filters and fluorochromes (continued)

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter
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Figure D-1  Base configuration

Octagon and Trigon Maps

This section shows how to install mirrors and filters in your octagon and trigons 
for the standard default configuration. 

If a slot is filled with a filter or mirror, an identifying number appears in that 
position on the configuration map. If a slot is filled with a blank optical holder, 
that position on the configuration map is unlabeled.
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Figure D-2  Standard default configuration: blue octagon
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Figure D-3  Standard default configuration: red and violet trigons 
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Figure D-4  Standard default configuration: UV trigon 
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Additional Optics

This section describes some common custom filter and mirror configurations. 
Table D-2 shows the detector arrays, mirrors, and filters used in the custom 
configurations, and recommended fluorochromes for each detector. The mirrors 
and filters used in these custom configurations are contained in the BD LSR II 
cytometer spares kit.

Maps on the following pages show how to install mirrors and filters in your 
octagon and trigons for common custom configurations.

Table D-2  Additional filters and mirrors

Detector Array (Laser) Mirror Filter Fluorochrome

blue octagon 
standard 488-nm blue laser

600 LP 610/20 PE-Texas Red™

635 LP 670/14 PerCP 
BD Cy-Chrome™ reagent

585/42 DsRed

violet trigon
optional 405-nm violet laser 

none none none

UV trigon 
optional 355-nm UV laser

450 LP Indo-1 (Blue)

405/20 Indo-1 (Violet)

red trigon 
optional 633-nm red laser

none none none
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PE-Texas Red™

To use PE-Texas Red™, replace the mirror and filter for the B PMT of the blue 
octagon as shown below.
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600 LP

780/60
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575/26
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PE-Cy7
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PE-Texas Red

488-nm blue laser
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Indo-1

If you have a violet laser, replace the mirror for the A PMT of the UV trigon as 
shown on the left below. 

If you do not have a violet laser, replace both the mirror for the A PMT and the 
filter for the B PMT of the UV trigon as shown on the right below. 

 

450/50

530/30

450 LP

Indo-1 (Blue)

Indo-1 (Violet)

405/20

530/30

450 LP

Indo-1 (Blue)

Indo-1 (Violet)

355-nm UV laser
(with violet laser)

355-nm UV laser
(no violet laser)
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DsRed

To use DsRed, replace the filter for the C PMT of the blue octagon as shown 
below.
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530/30

505 LP
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780/60

735 LP

585/42
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PE-Cy7DsRed

PerCP-Cy5.5

488-nm blue laser
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PerCP or BD Cy-Chrome Reagent

To use PerCP or BD Cy-Chrome reagent, replace the mirror and filter for the B 
PMT of the blue octagon as shown below.
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488-nm blue laser
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Appendix E

Special Order Configurations

The BD LSR II cytometer can be ordered with, or upgraded to, one of several 
laser and detector array options. You must use the Cytometer Setup and Tracking 
application to set up new configurations. See the Cytometer Setup and Tracking 
Applications Guide for more information.

This appendix contains the following information:

• Common Special Order Configurations on page 134

• Special Order Configuration Trigon and Octagon Maps on page 148
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Common Special Order Configurations

The following are commonly used configurations.

• 6-Blue 0-Violet 0-UV 3-Red Configuration on page 135

• 6-Blue 2-Violet 0-UV 3-Red Configuration on page 136

• 6-Blue 0-Violet 2-UV 3-Red Configuration on page 137

• 6-Blue 2-Violet 2-UV 3-Red Configuration on page 139

• 6-Blue 6-Violet 0-UV 3-Red Configuration on page 140

• 6-Blue 6-Violet 0-UV 4-Red Configuration on page 142

• 6-Blue 6-Violet 2-UV 3-Red Configuration on page 144

• 6-Blue 6-Violet 2-UV 4-Red Configuration on page 146
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6-Blue 0-Violet 0-UV 3-Red Configuration

6-Blue 0-Violet 0-UV 3-Red supports a blue octagon and a red trigon. 
Table E-1 shows the detectors, filters, and mirrors used in the default 
configuration. The word “blank” indicates that a blank optical holder should 
be used instead of a mirror or filter. A dash (—) indicates that no slot exists for 
a mirror in that PMT position.

The 6-Blue 0-Violet 0-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 149

• 3-Color Red Trigon Default Configuration Map on page 153

Table E-1  6-Blue 0-Violet 0-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC
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6-Blue 2-Violet 0-UV 3-Red Configuration

6-Blue 2-Violet 0-UV 3-Red supports a blue octagon, and violet and red trigons. 
Table E-2 shows the detectors, filters, and mirrors used in the default 
configuration. The word “blank” indicates that a blank optical holder should be 
used instead of a mirror or filter. A dash (—) indicates that no slot exists for a 
mirror in that PMT position.

The 6-Blue 2-Violet 0-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 149

• 2-Color Violet Trigon Default Configuration Map on page 150

• 3-Color Red Trigon Default Configuration Map on page 153

 

Table E-2  6-Blue 2-Violet 0-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none
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6-Blue 0-Violet 2-UV 3-Red Configuration

6-Blue 0-Violet 2-UV 3-Red supports a blue octagon, and UV and red trigons. 
Table E-3 on page 138 shows the detectors, filters, and mirrors used in the 
default configuration. The word “blank” indicates that a blank optical holder 
should be used instead of a mirror or filter. A dash (—) indicates that no slot 
exists for a mirror in that PMT position.

The 6-Blue 0-Violet 2-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 149

• 2-Color UV Trigon Default Configuration Map on page 152

• 3-Color Red Trigon Default Configuration Map on page 153

violet trigon 
(405-nm laser)

A 505 LP 525/50 AmCyan

B blank 450/50 Pacific Blue™

C — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC

Table E-2  6-Blue 2-Violet 0-UV 3-Red default mirror and filter configuration (continued)

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter
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Table E-3  6-Blue 0-Violet 2-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none

UV trigon 
(355-nm laser)

A 505 LP 530/30 Indo-1 (Blue)

B blank 450/50 Indo-1 (Violet), DAPI

C — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC
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6-Blue 2-Violet 2-UV 3-Red Configuration

6-Blue 2-Violet 2-UV 3-Red supports a blue octagon, and violet, UV, and red 
trigons. Table E-4 shows the detectors, filters, and mirrors used in the default 
configuration. The word “blank” indicates that a blank optical holder should be 
used instead of a mirror or filter. A dash (—) indicates that no slot exists for a 
mirror in that PMT position.

The 6-Blue 2-Violet 2-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 149

• 2-Color Violet Trigon Default Configuration Map on page 150

• 2-Color UV Trigon Default Configuration Map on page 152

• 3-Color Red Trigon Default Configuration Map on page 153

Table E-4  6-Blue 2-Violet 2-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none
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6-Blue 6-Violet 0-UV 3-Red Configuration

6-Blue 6-Violet 0-UV 3-Red supports blue violet octagons, and a red trigon. 
Table E-5 on page 141 shows the detectors, filters, and mirrors used in the 
default configuration. The word “blank” indicates that a blank optical holder 
should be used instead of a mirror or filter. A dash (—) indicates that no slot 
exists for a mirror in that PMT position.

The 6-Blue 6-Violet 0-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 149

• 6-Color Violet Octagon Default Configuration Map on page 151

• 3-Color Red Trigon Default Configuration Map on page 153

violet trigon 
(405-nm laser)

A 505 LP 525/50 AmCyan

B blank 450/50 Pacific Blue™

C — blank none

UV trigon 
(355-nm laser)

A 505 LP 530/30 Indo-1 (Blue)

B blank 450/50 Indo-1 (Violet), DAPI

C — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC

Table E-4  6-Blue 2-Violet 2-UV 3-Red default mirror and filter configuration (continued)

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter
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Table E-5  6-Blue 6-Violet 0-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none

violet octagon 
(405-nm laser)

A 630 LP 655/8 Qdot 655

B 595 LP 605/12 Qdot 605

C 575 LP 585/15 Qdot 585

D 545 LP 560/20 Qdot 565

E 475 LP 525/50 AmCyan, Qdot 525

F blank 450/50 Pacific Blue™

G blank blank none

H — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC
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6-Blue 6-Violet 0-UV 4-Red Configuration

6-Blue 6-Violet 0-UV 4-Red supports blue, violet, and red octagons. 
Table E-6 shows the detectors, filters, and mirrors used in the default 
configuration. The word “blank” indicates that a blank optical holder should 
be used instead of a mirror or filter. A dash (—) indicates that no slot exists for 
a mirror in that PMT position.

The 6-Blue 6-Violet 0-UV 4-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 149

• 6-Color Violet Octagon Default Configuration Map on page 151

• 4-Color Red Octagon Default Configuration Map on page 154

Table E-6  6-Blue 6-Violet 0-UV 4-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none
142 BD LSR II User’s Guide  



violet octagon 
(405-nm laser)

A 630 LP 655/8 Qdot 655

B 595 LP 605/12 Qdot 605

C 575 LP 585/15 Qdot 585

D 545 LP 560/20 Qdot 565

E 475 LP 525/50 AmCyan, Qdot 525

F blank 450/50 Pacific Blue™

G blank blank none

H — blank none

red octagon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C 675 LP 685/35 Alexa Fluor® 680

D — 660/20 APC

E blank blank none

F blank blank none

G blank blank none

H — blank none

Table E-6  6-Blue 6-Violet 0-UV 4-Red default mirror and filter configuration (continued)

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter
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6-Blue 6-Violet 2-UV 3-Red Configuration

6-Blue 6-Violet 2-UV 3-Red supports blue and violet octagons, and UV and red 
trigons. Table E-7 shows the detectors, filters, and mirrors used in the default 
configuration. The word “blank” indicates that a blank optical holder should be 
used instead of a mirror or filter. A dash (—) indicates that no slot exists for a 
mirror in that PMT position.

The 6-Blue 6-Violet 2-UV 3-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 149

• 6-Color Violet Octagon Default Configuration Map on page 151

• 2-Color UV Trigon Default Configuration Map on page 152

• 3-Color Red Trigon Default Configuration Map on page 153

Table E-7  6-Blue 6-Violet 2-UV 3-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none
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violet octagon 
(405-nm laser)

A 630 LP 655/8 Qdot 655

B 595 LP 605/12 Qdot 605

C 575 LP 585/15 Qdot 585

D 545 LP 560/20 Qdot 565

E 475 LP 525/50 AmCyan, Qdot 525

F blank 450/50 Pacific Blue™

G blank blank none

H — blank none

UV trigon 
(355-nm laser)

A 505 LP 530/30 Indo-1 (Blue)

B blank 450/50 Indo-1 (Violet), DAPI

C — blank none

red trigon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C — 660/20 APC

Table E-7  6-Blue 6-Violet 2-UV 3-Red default mirror and filter configuration (continued)
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6-Blue 6-Violet 2-UV 4-Red Configuration

6-Blue 6-Violet 2-UV 4-Red supports blue, violet, and red octagons, and a UV 
trigon. Table E-8 shows the detectors, filters, and mirrors used in the default 
configuration. The word “blank” indicates that a blank optical holder should be 
used instead of a mirror or filter. A dash (—) indicates that no slot exists for a 
mirror in that PMT position.

The 6-Blue 6-Violet 2-UV 4-Red maps are:

• 6-Color Blue Octagon Default Configuration Map on page 149

• 6-Color Violet Octagon Default Configuration Map on page 151

• 2-Color UV Trigon Default Configuration Map on page 152

• 4-Color Red Octagon Default Configuration Map on page 154

Table E-8  6-Blue 6-Violet 2-UV 4-Red default mirror and filter configuration

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter

blue octagon 
(488-nm laser)

A 755 LP 780/60 PE-Cy7

B 685 LP 695/40 PerCP-Cy5.5

C 655 LP 660/20 PE-Cy5

D 600 LP 610/20 PE-Texas Red™

E 550 LP 575/26 PE

F 505 LP 530/30 FITC, Alexa Fluor® 488

G blank 488/10 SSC

H — blank none
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violet octagon 
(405-nm laser)

A 630 LP 655/8 Qdot 655

B 595 LP 605/12 Qdot 605

C 575 LP 585/15 Qdot 585

D 545 LP 560/20 Qdot 565

E 475 LP 525/50 AmCyan, Qdot 525

F blank 450/50 Pacific Blue™

G blank blank none

H — blank none

UV trigon 
(355-nm laser)

A 505 LP 530/30 Indo-1 (Blue)

B blank 450/50 Indo-1 (Violet), DAPI

C — blank none

red octagon 
(633-nm laser)

A 755 LP 780/60 APC-Cy7

B 710 LP 730/45 Alexa Fluor® 700

C 675 LP 685/35 Alexa Fluor® 680

D — 660/20 APC

E blank blank none

F blank blank none

G blank blank none

H — blank none

Table E-8  6-Blue 6-Violet 2-UV 4-Red default mirror and filter configuration (continued)

Detector Array 
(Laser)

PMT 
(Detector)

Longpass 
Dichroic 
Mirror

Bandpass 
Filter

Fluorochrome or 
Scatter Parameter
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Special Order Configuration Trigon and 
Octagon Maps

If a slot contains a filter or mirror, a number appears in the corresponding 
position on the configuration map. If a slot contains a blank optical holder, 
nothing is written in the corresponding position on the configuration map.

The default configuration maps are:

• 6-Color Blue Octagon Default Configuration Map on page 149

• 2-Color Violet Trigon Default Configuration Map on page 150

• 6-Color Violet Octagon Default Configuration Map on page 151

• 2-Color UV Trigon Default Configuration Map on page 152

• 3-Color Red Trigon Default Configuration Map on page 153

• 4-Color Red Octagon Default Configuration Map on page 154
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6-Color Blue Octagon Default Configuration Map

57
5/

26

610/20

600 LP

PE-Texas Red

PE

530/30

505 LP

55
0 

LP

48
8/

10
695/40

685 LP

780/60

755 LP

660/20

655 LP

PE-Cy7PE-Cy5

PerCP-Cy5.5
SS

C

FITC

488-nm blue laser
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2-Color Violet Trigon Default Configuration Map

450/50

525/50

505 LP

AmCyan

Pacific Blue

405-nm violet laser
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6-Color Violet Octagon Default Configuration Map

52
5/

50

560/20

545 LP

Qdot 565

Am
Cy

an
450/50

47
5 

LP

Pacific Blue

605/12

595 LP

655/ 8

630 LP

585/15

575 LP

Qdot 655Qdot 585

Qdot 605

405-nm violet laser
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2-Color UV Trigon Default Configuration Map

450/50

530/30

505 LP

Indo-1 (Blue)

Indo-1 (Violet)

355-nm UV laser
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3-Color Red Trigon Default Configuration Map

730/45

710 LP

780/60

755 LP

660/20

APC-Cy7
APC

Alexa Fluor 700

633-nm red laser
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4-Color Red Octagon Default Configuration Map

660/20

APC

730/45

710 LP

780/60

755 LP

685/35

675 LP

APC-Cy7Alexa Fluor 680

Alexa Fluor 700

633-nm red laser
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Appendix F

Setting Laser Delay

This appendix describes how to optimize laser delay settings in a multiple laser 
system.

• About Laser Delay on page 156

• Optimizing Laser Delay on page 157
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About Laser Delay

Sample interrogation takes place within the cuvette flow cell. Laser light is 
directed through a series of prisms that focus multiple lasers on the event stream 
at different positions. This allows optimal detection of fluorescent signal from 
each laser with minimal cross-contamination from the other beams.

In the BD LSR II four-laser system, the blue laser intercepts the stream first, 
followed by the violet, UV, and red lasers. Because the laser signals are spatially 
separated, there is a slight delay between the detection of each laser’s signal 
(Figure F-1).

Figure F-1  Signal separation over time

The laser delay setting in BD FACSDiva software is used to realign the signals so 
they can be measured and displayed on the same time scale. Signals are aligned 
with respect to the blue laser, so the blue laser will have a 0 delay value, and the 
red laser will have the longest delay.

time

red

blue

UV

violet

event intercepts blue laser

event intercepts violet laser

event intercepts UV laser

event intercepts red laser
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Optimizing Laser Delay

Laser delay is set using BD FACSDiva software. To optimize the delay for a given 
laser, you acquire events from a sample with a fluorescence signal excited by that 
laser. Follow the procedures in Running Samples on page 53, for sample 
optimization and acquiring data.

To optimize laser delay:

1 While acquiring data from your sample, create a histogram to show the 
fluorescence signal excited by the laser in which the delay is to be 
optimized.

2 In the Acquisition Dashboard, set the Events to Display to 500 evt.

3 Select the Laser tab in the Cytometer window. 

Window extension and laser delay values are displayed in microseconds 
(µsec).

Figure F-2  Laser tab of the Cytometer window

4 Set the window extension value to 0 µsec.

5 Set an initial laser delay value ONLY for the laser you are optimizing.
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• If you are optimizing the violet laser, set its delay to 20 µsec.

• If you are optimizing the UV laser, set its delay to 40 µsec.

• If you are optimizing the red laser, set its delay to 60 µsec.

6 While observing the positive events on the histogram, adjust the laser delay 
in 1 µsec increments within a range of 10 µsec of the initial setting. 

Choose the setting that moves the events farthest to the right (highest 
fluorescence intensity).

7 Draw an interval gate on the histogram for the positive events. 

8 Create a statistics view to display the mean fluorescence intensity of the 
gated population. 

9 While observing the mean fluorescence intensity for the gated population, 
adjust the laser delay in 0.1 µsec increments within a range of 2.0 µsec of 
the setting obtained in step 6. 

You should also stay within a range of 10 µsec of the initial setting 
(see step 5).

Preserve the setting that maximizes the fluorescence intensity.

10 Reset the window extension to 10 µsec.
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Index
A

acridine orange (AO) 81
adjusting

threshold 63
voltages 63

air in filter, removing 50
alarm, waste container 31
ALPHA filters (AFs) 35
analysis

data 68
immunophenotyping 72
reusing 77
saving 77

antibodies 106
arm, tube support 30
assistance, technical xv

B

Bal seal, replacing 90
bandpass (BP) filters 35, 109

holder 42
specifications 45

battery test 85
Battery Test switch, shown 85
battery, changing 86
BD FACSClean solution 81
BD FACSDiva software See software
BD FACSFlow solution 47
BD FACSRinse solution 81
BD Falcon tubes 122

BD LSR II
components 26
cytometer optics 55
online Help xii
workstation 38

beam splitters See dichroic mirrors.
biohazards xx, 31
blank optical holders 42
bleach solution 81
blue laser 34
bubbles, removing air 50
buttons

fluid control 28
sample flow rate control 28

C

calculating compensation 66, 67
capacity, waste container 31
changing battery 86
Class I laser product xviii
Coherent lasers 34
compensation

calculating 66, 67
theory 111
tubes, creating 61

components
cytometer shown 26
optical bench 32

computer system, about 38
configuration maps 126
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containers, sheath and waste 31, 46, 49
control panel, cytometer 27
controls

compensation 61
single-stained 55, 68

cord, damaged xix
covers, cytometer 26
creating

analysis objects 72
compensation tubes 61
global worksheets 69
statistics view 73

custom configurations 130
cuvette flow cell 158
CV, troubleshooting 100
Cy-Chrome, filter configuration for 134
cytometer 26

components shown 26
configuration 43, 55
covers and door 26, 44
dimensions xiii
handles 27, 32
setup 54
spares kit 130
symbols and labels xxi

D

DAPI
cleaning after using 81

data
analyzing 68, 72
gating 72
recording 68, 70

debris
excessive 100
removing 63

delay, laser 158

detectors
photodiode 37
photomultiplier tubes (PMTs) 37
sensitivity 37

dichroic
filters 35
mirrors 35, 111

digital data 26
discriminating filters (DFs) 110
DNA

flow rate for analysis 104
droplet containment system 30

troubleshooting 94
DsRed, filter configuration for 133

E

electrical
requirements xiii
safety xix

electronics 114
emission duration 114
environmental requirements xiii
event rate

erratic 98, 99
high 97
low 98
zero 95, 96, 97

excessive debris 100
excitation wavelength 106
experiments

immunophenotyping 69
sample optimization 58

extra filters and mirrors 130

F

Falcon tubes 94
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filters
bandpass 35
optical

bandpass 35, 109
changing 44
dichroic 35
discriminating 110
extra 130
longpass 35, 108
shortpass 35, 109
specifications 45
theory 107

sheath
replacing 88

FITC and Stokes shift 106
fixed-alignment lasers 26
flow cell 104

draining 51
flow rate control buttons 28
fluid control buttons 28
fluidics 104

cleaning 80
description 28, 104
flow rate control 28
flushing system 83
priming 51
removing air bubbles 50
run mode 28
sample injection port (SIP) 29, 30

fluidics interconnect 50
fluorescence 106

emission 114
fluorochromes 111

emission spectra 107
filter configurations and 124, 130
role in light emission 106
which measured 43

forward scatter (FSC) 33, 34, 105
FSC and SSC voltages, adjusting 63
FSC threshold, adjusting 63

G

gating data 72
global worksheets 72

creating 69
previewing data 68, 77

H

handles, cytometer 27, 32
hazards

biological xx, 31
electrical xix
laser xvii

Hoechst 81
hydrodynamic focusing 104

I

immunophenotyping 104
analysis 72
data 69
experiment 69

indo-1, filter configuration for 132

J

JDS Uniphase HeNe 34

K

knob
SAMPLE FINE ADJ 28
sheath clamp, shown 46

L

labels on cytometer xxi
laser delay 157
161



lasers
about 34
classification xviii
power 34
quality control (QC) 52, 120
safety xvii
warming up 40
warmup times 34

longpass (LP) filters 35, 108
longpass dichroic mirrors

holder 42
specifications 45

LSR II See cytometer, BD LSR II.

M

maintenance
fluidics

daily cleaning 80
flushing system 83

periodic
Bal seal 90
replacing sheath filter 88
sample tube O-ring 92

scheduled
battery change 86
battery test 85
system flush 83
waste management system 85

Microsoft Windows operating 
system 38

mirrors
dichroic longpass 35
extra 130
specifications 45

N

NCCLS documents xx

O

octagon
description 32
detector 26
location 44
shown 36

optical bench components 32
optics 55

components 32
cover 33
custom filter configurations

DsRed 133
indo-1 132
PerCP or BD Cy-Chrome 134
PE-Texas Red 131

dichroic mirrors 35, 111
filters 35, 44, 107
location 26
steering 32, 36

optimization
sample 54

ordering spare parts 119
O-ring, sample tube, replacing 92

P

PerCP
filter configuration for 134
Stokes shift 106

PE-Texas Red 131
photodiode 37
photomultiplier tubes (PMTs) 32, 37
population hierarchy 72
power

requirements xix
switch 26

priming fluidics system 51
propidium iodide (PI)

cleaning after using 81
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pulse
definition 114
measurements 116
processors 116

Q

quality control (QC)
about 52
particles 120
troubleshooting 101

R

Radius laser 34
recording

compensation Tubes 65, 66
data 68, 70

red laser 34
removing air bubbles, filter 50
replacing

Bal seal 90
battery 86
optical filters 44
sample tube O-ring 92
sheath filter 88

requirements specifications xiii
reusing analyses 77

S

safety
biological xx
electrical xix
general xxi
laser xvii
symbols and labels xxi

sample
injection tube 30
optimization 54

experiment 58
single-stained controls 55, 68

tube requirements 94
SAMPLE FINE ADJ knob 28
sample injection port (SIP) 104

cleaning 80
components 29, 30
problems with 94
replacing Bal seal 90
replacing sample tube O-ring 92

samples, running 70
Sapphire laser 34
saving analyses 77
scatter

light 105
parameter distortion 99

setting laser delay 157
setup, cytometer 54
sheath

container 31, 46
filter

replacing 88
flow 104
fluid 104

backflush 30
pressure 104

sheath clamp knob 46
sheath container

cap 47
closing 47
depressurize 47

shortpass (SP) filters 35, 109
Show Population Hierarchy 73
shutdown, cytometer 80
side scatter (SSC) 34, 105
signals, amplifying 37
SIP See sample injection port.
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software
adjusting detector voltages 37
cytometer control xi

spares
filters and mirrors 130
kit 130
parts, ordering 119

specifications, filter and mirror 45
spillover 112
statistics views 72
steering optics 32, 36
Stokes shift 106
switch, Battery Test 85
symbols on cytometer xxi

T

technical assistance xv
Technical Assistance, assistance 

technical xv
temperature requirements xiii
testing battery 85
text conventions xi
thiazole orange (TO) 81
threshold

adjusting 63
defined 117

trigon 37
description 32
detector 26
location 44

tubes
compensation 61
requirements 94

U

ungrounded receptacles xix
user preferences 56
UV laser 34

V

violet laser 34
virus protection software xxiii
voltages, PMT, adjusting 63

W

waste container 31, 46
alarm 31
capacity 31
emptying 48

window extension 159
workstation, about 38
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